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Welcome to MASCHINE!

1 Welcome to MASCHINE!

Thank you for buying MASCHINE!

MASCHINE is a groove production studio that implements the familiar working style of classi-
cal groove boxes along with the advantages of a computer based system. MASCHINE is ideal
for making music live, as well as in the studio. It’s the hands-on aspect of a dedicated instru-
ment, the MASCHINE hardware controller, united with the advanced editing features of the
MASCHINE software.

Creating beats is often not very intuitive with a computer, but using the MASCHINE hardware
controller to do it makes it easy and fun. You can tap in freely with the pads or use Note Re-
peat to jam along. Alternatively, build your beats using the step sequencer just as in classic
drum machines.

Patterns can be intuitively combined and rearranged on the fly to form larger ideas. You can try
out several different versions of a song without ever having to stop the music.

Since you can integrate it into any sequencer that supports VST, AU, or AAX plug-ins, you can
reap the benefits in almost any software setup, or use it as a stand-alone application. You can
sample your own material, slice loops and rearrange them easily.

However, MASCHINE is a lot more than an ordinary groovebox or sampler: it comes with an
inspiring 7-gigabyte library, and a sophisticated, yet easy to use tag-based Browser to give you
instant access to the sounds you are looking for.

What's more, MASCHINE provides lots of options for manipulating your sounds via internal ef-
fects and other sound-shaping possibilities. You can also control external MIDI hardware and
3rd-party software with the MASCHINE hardware controller, while customizing the functions of
the pads, knobs and buttons according to your needs utilizing the included Controller Editor
application. We hope you enjoy this fantastic instrument as much as we do. Now let’'s get go-
ing!

—The MASCHINE team at Native Instruments.
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1.1 Where to Start?

MASCHINE provides you with many information sources. The main documents are meant to be
read in the following sequence:

1. MASCHINE Setup Guide
2.  MASCHINE Getting Started and online video tutorials
3. MASCHINE Manual (this document)

The whole documentation set is available in PDF format and located within the MA-
SCHINE installation folder on your hard disk. You can also access these documents
from the Help menu in the Application Menu Bar or from the Help submenu in the MA-
SCHINE menu.

Please check the Service Center or the Native Instruments website regularly for up-to-
date and localized versions of these documents. You can start the Service Center by se-
lecting Launch Service Center from the Help menu in the Application Menu Bar or from
the Help submenu in the MASCHINE menu.

Additional documentation sources provide you with details on more specific topics:
= MASCHINE Hardware Control Reference
= Controller Editor Manual

Hereafter is a quick description of each of these documentation sources.

Your First Stop: the Setup Guide

The Setup Guide will guide you through the software and hardware installation of MASCHINE,
from the very beginning to the first sound coming through your speakers.

First read the Setup Guide. Then proceed with this MASCHINE Getting Started to get more fa-
miliar with MASCHINE.
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MASCHINE Getting Started

After reading the Setup Guide and following its instructions, your MASCHINE should be up
and running. The next step is to read the MASCHINE Getting Started. This gives you a practi-
cal approach to MASCHINE via a set of tutorials covering easy and more advanced tasks in or-
der to help you familiarize yourself with MASCHINE.

Video Tutorials

The Native Instruments website provides you with a lot of video tutorials that give you a hands-
on approach to many sides of the MASCHINE workflow. To see them, point your favorite brows-
er to following URL: http://native-instruments.com/maschinemedia.

MASCHINE Manual

This MASCHINE Manual provides you with a comprehensive description of all MASCHINE soft-
ware and hardware features.

MASCHINE Hardware Control Reference

The MASCHINE Hardware Control Reference provides an overview of a MASCHINE Project, the
quick access options performed using the MASCHINE hardware controller, and lots of key-
board shortcuts.

Controller Editor Manual

Besides using your MASCHINE hardware controller together with its dedicated MASCHINE
software, you can also use it as a powerful and highly versatile MIDI controller to pilot any oth-
er MIDl-capable application or device. This is made possible by the Controller Editor software,
a little application that allows you to precisely define all MIDI assignments for your MASCHINE
controller. The Controller Editor should have been installed during the MASCHINE installation
procedure. For more information on this, please refer to the Controller Editor Manual available
as a PDF file in the Documentation subfolder of the Controller Editor installation folder on your
hard disk.

Other Online Resources

If you are experiencing problems related to your Native Instruments product that the supplied
documentation does not cover, there are several ways of getting help:
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= Knowledge Base

= User Forum

= Technical Support

= Registration Support

You will find more information on these in chapter 115, Troubleshooting — Getting Help.

1.2 Manual Conventions

This section introduces you to the signage and text highlighting used in this manual. This man-
ual uses particular formatting to point out special facts and to warn you of potential issues.
The icons introducing these notes let you see what kind of information is to be expected:

This document uses particular formatting to point out special facts and to warn you of poten-
tial issues. The icons introducing the following notes let you see what kind of information can
be expected:

@ The speech bubble icon indicates a useful tip that may often help you to solve a task
more efficiently.

The exclamation mark icon highlights important information that is essential for the giv-
en context.

® The red cross icon warns you of serious issues and potential risks that require your full
attention.

Furthermore, the following formatting is used:

= Text appearing in (drop-down) menus (such as Open..., Save as... etc.) in the software and
paths to locations on your hard disk or other storage devices is printed in italics.

= Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) in the
software is printed in blue. Whenever you see this formatting applied, you will find the
same text appearing somewhere on the screen.
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Text appearing on the displays of the controller is printed in light grey. Whenever you see
this formatting applied, you will find the same text on a controller display.

Text appearing on labels of the hardware controller is printed in . Whenever you see
this formatting applied, you will find the same text on the controller.

Important names and concepts are printed in bold.

References to keys on your computer’'s keyboard you'll find put in square brackets (e.g.,
“Press [Shift] + [Enter]”).

Single instructions are introduced by this play button type arrow.

Results of actions are introduced by this smaller arrow.

Naming Convention

Throughout the documentation we will refer to MASCHINE controller (or just controller) as the
hardware controller and MASCHINE software as the software installed on your computer.

The term “effect” will sometimes be abbreviated as “FX” when referring to elements in the MA-
SCHINE software and hardware. These terms have the same meaning.
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2 Basic Concepts

This chapter will reintroduce you to MASCHINE's main elements and terminology and explain
how they relate to one another. You will also learn how to set up your audio interface and how
to connect MIDI devices.

Before reading this chapter it is strongly recommended that you read the MASCHINE
Getting Started first.

2.1 Names and Concepts You Should Know
We will start with a list defining the most important concepts and names.

Browser

The Browser is the front end for accessing all the elements of your MASCHINE Projects:
Projects, Groups, Sounds, instruments and effect presets, and Samples. Each of these can be
stored and tagged in a way that allows you easy access to all of them. MASCHINE's factory
library is already completely tagged, as well as factory libraries of any Native Instruments prod-
ucts installed on your computer. You can also import your own files to the Library and tag them
as well. To learn more about the Browser, please read chapter 13, Browser.

Project

A Project contains all data needed for a song: Groups with their Patterns, all Scenes and all
settings, modulation, effects, routings, Sounds and Samples. It's like a snapshot of the entire
state of MASCHINE. Please read the MASCHINE Getting Started for a complete overview of
the MASCHINE Project structure.
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Sound

Sounds are the building blocks of all sound content in MASCHINE. A Sound is made up of any
number of Plug-ins. Each Sound of the selected Group is mapped to one of the 16 pads on the
hardware controller, so you can play the Sounds by pressing the pads. Refer to chapter 14,
Managing Sounds, Groups, and Your Project for more information on Sounds.

Group

A Group contains 16 Sound slots. In addition to the Effect Plug-ins applied to each individual
Sound, a Group can have its own insert effect. These affect all the Sounds in the Group. A
Group can also contain any number of Patterns (grouped into banks of 16 Patterns each). Re-
fer to chapter 14, Managing Sounds, Groups, and Your Project for more information on Groups.

Master

This is where all audio signals from each of the Groups and Sounds come together and get
mixed. The Master channel can also host any number of insert effects of its own, these effects
are applied to all Groups and the Sounds within them. More information on the Master can be
found in chapter 14, Managing Sounds, Groups, and Your Project.

Pattern

A Pattern is a sequence that plays Sounds from a Group. It belongs to that Group and will be
saved together with the Group. In every Scene you can choose for each Group which of its Pat-
terns has to be played. More information on Patterns can be found in chapter 16, Working with
Patterns.

Scene

A Scene is a combination of Clips for your different Groups. Each Clip references a specific
Pattern of a Group. In a Scene you can create one Clip for each Group. Scenes are located in
the Arranger. They can be used to build up a finished arrangement or to trigger different parts
of a song during a live performance. Refer to chapter 112, Creating a Song Using Scenes for
more information on Scenes.
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Event

Events are the individual drum hits or notes that make up a Pattern. In the Pattern Editor,
events are visually represented by rectangles in the Event area. Depending on the current view
in the Pattern Editor, you can see events for all Sounds slots (Group view) or for the selected
Sound slot only (Keyboard view). Events are described in more detail in chapter 16, Working
with Patterns.

Plug-in

Each Sound, each Group, and the Master can hold any number of Plug-ins. Plug-ins can be
instruments or effects, and they can be internal (included with MASCHINE), from other Native
Instruments products (instruments or effects), or external (third-party VST/AU plug-ins). Instru-
ment and Effect Plug-ins can be loaded in the first Plug-in slot of Sounds. The other Plug-in
slots of Sounds, as well as the Plug-in slots of Groups and of the Master can hold Effect Plug-
ins only. At each level (Sound, Group, and Master), Plug-ins process the audio in series, ac-
cording to the order in which they are stacked up. Refer to chapter 15, Working with Plug-ins.

Effect

MASCHINE comes with many different effects in the form of Internal Plug-ins. You may also
use Native Instruments or third-party VST/AU effect plug-ins. Each Sound, each Group, and
the Master can hold any number of effects that will be applied as insert effects. The flexible
routing system also allows you to create send effects, multi-effects, and side-chains. For more
details on using effects in MASCHINE, refer to chapter 110, Using Effects. You will find an
exhaustive description of all internal effects included in MASCHINE in chapter 111, Effect
Reference.

@ Please refer to chapter 117, Glossary at the end of this Manual for more definitions!

2.2 Adjusting the MASCHINE User Interface

The MASCHINE software user interface is very flexible. You can choose what to display and
what not, allowing you to focus on your workflow. This section shows you how to adjust the MA-
SCHINE GUI to suit your needs.

MASCHINE 2 - Manual - 27



Basic Concepts
Adjusting the MASCHINE User Interface

2.2.1  Adjusting the Size of the Interface

From the View menu in the Application Menu Bar and from the View submenu in the MA-
SCHINE menu you can select one of four different sizes to display MASCHINE’s software GUI:

File Edit [View | Controller Help
b?owser F4

v | Arranger

Mizer

Small

Medium

Large

Fullscreen Ctrl+F

The View menu in the Application Menu Bar (Windows depicted).

© MASCHINE

New Project

Group A1 Browsear
+ Arranger
Mixer

Small
Madium
SOUND Aux e

AUDIO Fullscreen

The View submenu in the MASCHINE menu.

Full screen view is also available from your computer keyboard via [Ctrl]+[F] (Mac OS X:
[CmdI+[F]).
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2.2.2  Showing/Hiding the Browser

» Click the Browser button (with the magnifier symbol) in the Header to show and hide the
Browser. You can also select Browser from the View menu in the Application Menu Bar or
from the View submenu in the MASCHINE menu.

© MASCHINE

New Project

Scene 1

S

The Browser button in the Header.

You can also show/hide the Browser from your computer keyboard via the [F4] function
key.

2.2.3  Switching between Arrange View and Mix View

» Click the Mix View button at the top left of the Arranger to switch between the Arrange
view and the Mix view. You can also select Arranger or Mixer from the View menu in the
Application Menu Bar or from the View submenu in the MASCHINE menu.

TR N O |

New Project
Scene 1

EK-TL A Kit Pattern 1

The Mix View button.
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You can also switch between Arrange view and Mix view from your computer keyboard
via the [Tab] key.

2.24  Minimizing the Mixer

When MASCHINE is in Mix view, you can minimize/maximize the Mixer in the top part of the
MASCHINE window:

» Click the arrow button at the bottom left of the Mixer to show and hide the channel de-
tails in the Mixer.

Snare..tl A1

GROUP GROUP

Minimizing/maximizing the Mixer.

2.2.5  Showing/Hiding the Control Lane

When MASCHINE is in Arrange view, you can show/hide the Control Lane under the Pattern
Editor:

» Click the arrow button on the bottom left of the Pattern Editor to show and hide the Con-
trol Lane.
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Kick Ektl A 1
> Ektl A 1

ydHH Ektl A

‘]

8
a

@ Velocity

Click the arrow button at the bottom left of the Pattern Editor to show/hide the Control Lane.

2.3  Common Operations

This sections introduces a few very common operations in MASCHINE you will encounter in
numerous situations.

2.3.1  Setting the Focus on a Group or a Sound

To display the content and parameters of a particular Sound or Group, you first need to put it
in focus.

Setting the focus on a Sound or Group is slightly different than selecting it: The focus defines
what will be displayed, whereas the selection defines what will be affected by your edits. Note
that a focused Sound/Group is always selected. The distinction is of importance because you
can select multiple Sounds or Groups to apply your edits to all of them at once! See section
14.1.3, Selecting Multiple Sounds or Groups for more on this.
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We show here how to put Sounds and Groups in focus when the MASCHINE software is
in Arrange view (default view). For instructions on putting Sounds and Groups in focus
in Mix view, please refer to chapter 18.2.3, Selecting Channel Strips.

Setting the Focus on a Group

» To put a Group in focus, click this Group in the Group List of the Arranger:

©)

Come Into My Disco «

BE1

C1

D1 Extra Drums
H 1Bar

— The focused Group is highlighted. The Pattern Editor displays the Sounds and Patterns of
that Group.
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Come Into My Disco =

Al Lead
Beat

C1 Amblence

SOUND Aux

AUDIO

Automation

Kick Autopsy 1

Kick MuPop 1

The focused Group is highlighted and the Pattern Editor show its content.

If the desired Group does not appear in the Group List, use the scroll bar at the right
end of the Arranger or turn your mouse wheel while hovering the Arranger to display any
hidden Groups. You can also extend the Arranger by dragging its lower right corner verti-
cally with the mouse.

You can also select multiple Groups at once to apply changes to all of them. See section
14.1.3, Selecting Multiple Sounds or Groups for more information.

Setting the Focus on a Sound

To put a Sound in focus:
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1. Set the focus to the Group containing the desired Sound by clicking it in the Group List
on the left of the Arranger (see above).

©

Come Into My Disco ~

The focused Group is highlighted. The Pattern Editor displays the Sounds and Patterns of
that Group.

2. Click the desired Sound slot in the Sound List of the Pattern Editor:

Kick Autopsy 1

4 ri
m ClosadHH Boundary

& I Triangle SoulOne

The focused Sound slot is highlighted.
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If the desired Sound does not appear in the Sound List, use the scroll bar at the right
end of the Pattern Editor or turn your mouse wheel while hovering the Pattern Editor to
display any hidden Sounds.

You can also select multiple Sounds at once to apply changes to all of them. See sec-
tion 14.1.3, Selecting Multiple Sounds or Groups for more information.

2.3.2  Switching Between the Master, Group, and Sound Level

At any time you can quickly switch the Control area between the parameters of the Master, the
focused Group, and the focused Sound.

[ 5
The Finger

Click the desired tab to switch the display of the Control area.

» Click the MASTER, GROUP or SOUND tab in the top left corner of the Control area to
display the Plug-in parameters or Channel properties of the Master, the focused Group or
the focused Sound, respectively.

— The selected tab lights up. The name of your Project, the focused Group or the focused
Sound appears under the MASTER, GROUP, and SOUND tabs (the Muddy Matt Sound in
the picture above), and the rest of the Control area displays the Plug-in parameters and
Channel properties of the Master, the focused Group or the focused Sound, respectively.

2.3.3  Navigating Channel Properties, Plug-ins, and Parameter Pages in the Control Area

We describe here how to display/edit any Plug-in parameters or Channel properties located in
any Sound, Group or the Master.

To select a particular Plug-in or a particular set of Channel properties, you first need to display
the parameters of the Master, the desired Group or the desired Sound.
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1. To display the parameters of a particular Group or Sound, put it in focus by clicking it in
the Group List or Sound List, respectively (see section 12.3.1, Setting the Focus on a
Group or a Sound above).

2. In the top left corner of the Control area, click the MASTER, GROUP or SOUND tab to
display the parameters of the Master, the focused Group or the focused Sound, respec-
tively.

— The Control area now displays the Plug-in parameters and Channel properties of the de-
sired Sound, desired Group or the Master.

Selecting Channel Properties

1. At the far left of the Control area, click the Channel icon (showing a little knob) to display
the Channel properties:

SWING

The button lights up. The Channel Property selector appears in the left part of the Control
area, showing a square of four buttons representing the various sets of Channel properties
available for the selected Sound, Group or the Master:

SWING

*

Groove Amount

2. Click the desired button (Input, Output, Groove, or Macro) in the Channel Property selec-
tor to select that set of Channel properties.

— The selected button is highlighted and the parameters of the selected Channel properties
appear in the Parameter area (the right and biggest part of the Control area).
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Selecting a Plug-in

1. At the far left of the Control area, click the little Plug-in icon to display the Plug-ins:

The icon lights up. The Plug-in List appears in the left part of the Control area, showing a
stack of all Plug-ins loaded in the selected Sound, Group or the Master:
Fraq / Gain

hid samplar

EQ
m Matavearb
+

2. Click the desired Plug-in slot in the Plug-in List to select that Plug-in.

— The parameters of the selected Plug-in appear in the Parameter area (the right and big-
gest part of the Control area).

If the Plug-in List only shows a “+” sign, it means that there are no Plug-ins loaded in

this Sound, Group or the Master. Clicking the “+” sign allows you to load a new Plug-in:
see section 15.1.3, Loading, Removing, and Replacing a Plug-in for more on this.

Navigating Parameter Pages

In some situations, the selected Plug-in or Channel properties provide more parameters than
the display(s) of your controller and the Parameter area in the software can show at once. Ex-
amples of this are the parameters for the Groups’ or Sounds’ Output properties and those for
the Sampler Plug-in. In these cases, the parameters are divided into several Parameter pages
that you can easily navigate with the hardware and software.

In the software the names of the available pages are displayed at the top of the Parameter
area. The name of the page currently displayed is highlighted.

» Click the desired page name at the top of the Parameter area to show the corresponding
Parameter page.

MASCHINE 2 - Manual - 37



Basic Concepts

Common Operations

SOUND [ENGIEE  Aux MIDI

AUDIO

Audio Mute

The Parameter pages of the Sound’s Output properties: Audio (currently displayed), Aux, and MIDI.

If all page names cannot be displayed at once at the top of the Parameter area, two small ar-
rows are displayed on the left to click through the pages:

SOUND 7 4k Mas Ise Mas Filtar Ma: Vas Env Mas Env2

Scratchy £ MAS FILTER
-
-

<«
l" Massive
+ (OO ¢ ™)

F1 Cutoff F1 Mod F1 Raso F1 Gain F2 Cutoff F2 Mod 2 Reso F2 Gain

» Click the left or right arrow to access additional pages.

Adjusting the Parameters

In the Parameter area, each parameter includes a control element and a label. Following types
of control elements are available:
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Element Action

Knob: Click the knob and drag your mouse vertically to change
the parameter value. Hold [Shift] on your computer keyboard and
drag your mouse to adjust the value in finer increments.

Button: Click the button to switch its state. When the button is
enabled, it shows a small colored LED.

Selector: Click the displayed value to open the drop-down list,
and click another value in the list to select it.

2.3.4 Undo/Redo

Undoing and re-doing your last actions can be useful to cancel operations you have performed
or to compare two versions before and after a change. You can undo nearly everything you did
after loading or creating your Project.

Note: If you save your Project, you will no longer be able to undo or redo any actions
performed before saving!

MASCHINE 2.0 provides two different undo/redo features, each of them being suited for spe-
cific situations:

= Step Undo allows you to cancel your last single action.

= Take Undo allows you to cancel your last group of actions.

Step Undo

Step Undo/Redo is the classic undo/redo found in most applications. It cancels or re-executes
each single action you have performed.
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In the software use the following keyboard shortcuts for the Step Undo and Step Redo func-
tions:

» To cancel your last action (Step Undo), press [CtrI]+[Shift]+[Z] ([Cmd]+ [Shift]+ [Z] on
Mac OS X). To re-execute your last action (Step Redo), press [Ctrl]+ [Shift]+ [Y] ([Cmd]+
[Shift]l+ [Y] on Mac OS X). You can also select Undo Step and Redo Step from the Edit
menu in the Application Menu Bar or from the Edit submenu in the MASCHINE menu.

@ The commands in the Edit menu additionally shows which action will be undone/redone!

Take Undo

Suppose you have just recorded a 16th-note hi-hat beat over four bars, but then decide to can-
cel it. Normally you would have to cancel the 64 notes one at a time, repeatedly calling the
undo function 64 times in a row. This is what Take Undo has been made for!

Take Undo/Redo is an extended undo/redo available while recording that allows you to cancel
or re-execute a whole group of actions at once.

Take Undo/Redo is the default undo/redo in MASCHINE. In the software use the common key-
board shortcuts for the Undo and Redo functions:

» To cancel your last group of actions, press [Ctrl]+[Z] ((Cmd]+[Z] on Mac OS X). To re-exe-
cute your last group of actions, press [Ctrl]+[Y] ([Cmd]+[Y] on Mac OS X). You can also
select Undo and Redo from the Edit menu in the Application Menu Bar or from the Edit
submenu in the MASCHINE menu.

@ The commands in the Edit menu additionally shows which action will be undone/redone!

Take Undo is available in following situations:
= Recording in Control mode
= Recording in Step mode

= Recording modulation
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QOutside of these three situations, Take Undo has the same effect as Step Undo (see
above).

2.3.5  Pinning a Mode on Your Controller

Besides the default Control mode, your controller has various other modes of operation, which
you can enter by pressing their dedicated buttons. Depending on their purpose and workflow,
these controller modes are of two types:

= Temporary modes only stay active as long as you hold down their button on the controller.
When you release the button, your controller returns to Control mode. This is for example
the case with the button.

= Permanent modes stay active even if you release their button. To deactivate them, you must
press their button a second time. This is for example the case with the button.

But in some situations you might want to release the mode button of a temporary mode with-
out leaving that mode, e.g., to free your hand and tweak other controls more easily. For this
purpose, MASCHINE lets you pin (or “lock”) temporary modes so that they behave like perma-
nent modes.

2.3.6  Using Two or More Hardware Controllers

If two or more MASCHINE controllers of different types (MASCHINE STUDIO, MASCHINE
MK2, MASCHINE MIKRO MK2, MASCHINE, and MASCHINE MIKRO) are connected to your
computer, only one controller can be used to control the MASCHINE software at a time.

@ If you have more than one instance of the MASCHINE software running on your comput-
er, you can control each instance with a different controller. See Controlling Various In-
stances with Different Controllers for more information.

@ A controller not connected to any MASCHINE software instance can be used in MIDI
mode (i.e. as a MIDI controller) at the same time as the other controller(s). See the Con-
troller Editor Manual for more information on MIDI mode.

You can choose which controller you want to use with the MASCHINE software. This can be
done both from your controller and in the software.
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You can select the desired controller from the Controller menu in the Application Menu Bar or
from the Controller submenu in the MASCHINE menu:

File Edit View | Controller | Help
@ MAS( MASCHINE MIKRO

LIBRARY

File Raminagrobis

MASCHINE MIKRO ME2 L\\s
. Edit
MASCHINE -

MASCHINE MK2 View
Co Il MASCHINE MIKRO
v MASCHINE STUDIO ntroller

MASCHINE MIKRO MK2 I}
MASCHINE
MASCHINE MK2

v MASCHINE STUDIO

Click the Controller menu (left) or the Controller submenu in the MASCHINE menu (right) and select the controller you want
to use (Windows depicted).

Hardware
On the controller you want to use with the MASCHINE software, do the following:
= MASCHINE STUDIO controller: Press + , turn the jog wheel to select the
desired instance, and press the jog wheel or Button 8 to load it.
= MASCHINE (MK2) controller: Press + , turn Knob 5 (or press Button 5/6) to
select the desired instance, and press Button 8 to load it.
= MASCHINE MIKRO (MK2) controller: Press + 2, turn the Control encoder to select

the desired instance, and press the Control encoder to load it.

2.4  Native Kontrol Standard

Native Kontrol Standard (NKS) is a software instrument format that allows third-party develop-
ers to integrate with MASCHINE and KOMPLETE KONTROL hardware and software at the
same deep level as KOMPLETE Instruments.

The Native Kontrol Standard includes:
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= Seamless integration into the MASCHINE and KOMPLETE KONTROL Browser for a unified
browsing experience.

= Full parameter mapping for instant hands-on control.
= Support of KOMPLETE KONTROL S-SERIES features such as the Light Guide.

This means that instruments supporting NKS can be found in the MASCHINE Browser next to
your KOMPLETE Instruments. All of their presets are fully tagged, so you can use filters to
search for sounds from all of your NKS and KOMPLETE Instruments. When you load a preset
from an NKS instrument, all of its parameters are mapped to the controls on your MASCHINE
hardware in a meaningful way, just like any preset from your KOMPLETE Instruments.

NKS instruments are automatically added to your Library when you start MASCHINE for the
first time after installing the instrument (except KONTAKT instruments with NKS support, see
below).

The folders containing the preset files for NKS support can be managed in the Factory
pane on the Library page of the Preferences.

2.4.1  Installing KONTAKT Instruments with NKS Support

Third-party developers of KONTAKT instruments provide you with a folder that contains all in-
strument files, including presets and samples. Instead of running an installer, this folder needs
to be stored on the hard drive and added to the KONTAKT Browser by using KONTAKT's Add
Library function.

As a MASCHINE user, you can add KONTAKT instruments with NKS support to your MA-
SCHINE Library by dragging the folder onto the MASCHINE Browser. If you are using KON-
TAKT, the instrument is automatically added to your KONTAKT Browser, too.
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» To add a KONTAKT instrument with NKS support to your MASCHINE Library, drag the
instrument folder onto the MASCHINE Browser.

© MASCHINE ° 120.00

LIBRARY New Project
[ soup T ————

All Instruments

» Computer » Data (HDD) (D:) » KontaktInstruments »

7 Open Includein library Share with + Bum New folder

Name

W Favorites

[PR
01LPEp O Bl Desktop

Archetype
Capriccio
Gravity

REV X-LOOPS

8 Downloads

%] Recent Places

4 Libraries
[= Documents
& Music
>1° ° &) Pictures
@ | Velocity e & videos
+ ]
0 % Computer
=] & e X B, 05 (55D) (¢

— The KONTAKT instrument is now available in the Library pane of the MASCHINE Brows-
er.

The MASCHINE Library and the KONTAKT Browser reference the instrument files con-
tained in the folder. Do not delete or move the folder afterwards, otherwise MASCHINE
and KONTAKT will not be able to access the instrument files.

24.2  Loading NKS and Third-party Plug-ins from the Plug-in Menu

The plug-in menu has been updated to display NKS and third-party plug-ins in submenus sort-
ed by vendor in alphabetical order, both within the software and hardware.

The plug-in menu lists installed plug-ins in the following format:
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Instrument Plug-ins Effect Plug-ins

Internal Plug-ins | Sampler, Drumsynths MASCHINE internal effects

Native Instruments | VST/AU instrument plug-ins from VST/AU effect plug-ins from Native

Plug- ins Native Instruments’ range of Instruments’ range of products
products

NKS and Third- NKS and Third-party VST/AU Third-party VST/AU effect plug-ins

party Plug-ins instrument plug-ins

None
Intarnal
Mative Instruments

Arturia Jupiter-8 V2
GForca Prophet V2

iZotope, Inc. Spark
Wurlitzer V

Plug-in menu displaying NKS and third-party plug-ins

For more information on using Plug-ins and accessing the plug-in menu please refer to chapter
6 “Working with Plug-ins” in the MASCHINE manual.

2.5  Stand-Alone and Plug-in Mode

You can run the MASCHINE software as a stand-alone application or integrate it into your fa-
vorite Digital Audio Workstation (or DAW, in short) by loading it as a plug-in. The MASCHINE
software is available in the VST, Audio Unit, and AAX plug-in formats. For further information
on plug-in compatibility and for a detailed description of how to use plug-ins in your host,
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please refer to the documentation included with your host software. If you did not install the
plug-ins when installing the MASCHINE software, please refer to the Setup Guide available
from the documentation folder in the MASCHINE software installation folder.

2.5.1 Differences between Stand-Alone and Plug-in Mode

Transport Functions

The most noticeable difference between the stand-alone and plug-in mode of MASCHINE re-
lates to the interaction with MASCHINE’s sequencer. Indeed, when MASCHINE is used as a
plug-in within a host sequencer software (e.g., Cubase or Pro Tools), MASCHINE's sequencer
is exclusively controlled by the host application: you cannot, e.g., manually start, stop or re-
start the playback in MASCHINE, nor modify the tempo or the time signature of your Project
within the MASCHINE plug-in itself — these are synchonized to your host’s own transport
functions and tempo settings. As a direct consequence, when MASCHINE is used as a plug-in
the Restart and Play buttons as well as the Tempo and Time Signature fields are grayed out
and inactive in the MASCHINE Header. Obviously you cannot control MASCHINE’s playback
and tempo settings from your MASCHINE controller either.

However from your controller you can directly control the transport functions of your host
application instead. See section Controlling your Host’s Transport Functions in Plug-in
Mode for more information.

Audio and MIDI Handling

When MASCHINE is used in stand-alone mode, it directly communicates with your audio and
MIDI interface. You can select which physical audio/MIDI ports have to be used on your inter-
face, and configure crucial audio settings like the sample rate. All this is done via the Audio
and MIDI Settings panel (for more information on this, please refer to Integrating MASCHINE
into Your MIDI Setup).

On the contrary, When MASCHINE is used as a plug-in within a host application, the commu-
nication with your audio and MIDI interfaces is managed by the host — the MASCHINE plug-
in only communicates with the host. Native Instruments’ Online Knowledge Base provides
how-tos that will help you route the MASCHINE plug-in to multiple tracks/outputs in the major
hosts:
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= How to route MASCHINE to multiple outputs in Ableton Live:
http://www.native-instruments.com/knowledge/questions/1705

= How to route MASCHINE to multiple outputs in Cubase:
http://www.native-instruments.com/knowledge/questions/1707

= How to route MASCHINE to multiple outputs in Pro Tools:
http://www.native-instruments.com/knowledge/questions/1709

= How to route MASCHINE to multiple outputs in Logic Pro:
http://www.native-instruments.com/knowledge/questions/1711

For all details on the audio and MIDI configuration of your host application, please refer
to its documentation.

Multiple Plug-in Instances

When you are using MASCHINE as a plug-in within a host application, you can open multiple
MASCHINE instances. Actually, you can load as many instances of MASCHINE as your com-
puter and your host application can handle CPU-wise. In contrast to the stand-alone applica-
tion, they are always synced to the host. In plug-in mode you can also send MIDI Program
Change messages from your host to switch between MASCHINE’s Scenes or between patches
of other plug-ins loaded into MASCHINE, or record automation for MASCHINE parameters. To
learn more about these, have a look at chapter 112.4, Triggering Scenes via MIDI (MASCHINE
Plug-in Only) and 17.2, Using MIDI Control and Host Automation.

2.5.2  Switching Instances

When two or more instances of the MASCHINE software are running (e.g., as plug-ins on dif-
ferent tracks of your DAW), you must choose which instance you want to control from your
hardware controller. You can do this both from your controller and in the software.

» To select your controller from a particular MASCHINE instance, click the Connect button
in the MASCHINE Header of that instance.

A CPU ) I:m

Click the Connect button to connect the controller to that instance.
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2.6  Preferences

The Preferences panel lets you specify various settings for MASCHINE.

» To open the Preferences panel, click Preferences... in the Maschine menu (Mac OS X) or
File menu (Windows) of the Application Menu Bar, or in the File submenu of the MA-
SCHINE menu:

Edit View Controller Help

Mew Ctrl+M
Open... Ctrl+ O
Open Recent 2
Open Recent
Save Ctrl+5
Save
Save As.. Ctrl+Shift+5 Save As...
Save Project with Samples... Sawe Project with 8 —
Import Maschine1.x Format... - Import Maschine 1.x Format...
uroan
Export Audio... Export Audio...
e e % Prafarances...
Exit

Preferences... in the File menu of the Application Menu Bar (Windows depicted), and in the File submenu of the MA-
SCHINE menu.

The following pages are available in the Preferences panel:
= General: see 12.6.1, Preferences — General Page.
= Default: see 12.6.4, Preferences — Default Page.
= Library: see 12.6.5, Preferences — Library Page.
= Plug-ins: see 12.6.6, Preferences — Plug-ins Page.
= Hardware: see 12.6.7, Preferences — Hardware Page.

= Colors: see 12.6.9, Preferences — Colors Page.
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2.6.1 Preferences — General Page

The General page holds a few global settings.

» To display the General page click the General tab on the left of the Preferences panel.

Preferences

Startup

Reload Last Projec
Recording Audio
Prefer Project Folder
Metronome
Enabled

Auto-Enable when Recording

Count-in Lengtt
Input

The Preferences — General page.
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Setting Description

Startup

Reload Last Project If this option is checked, the last Project you worked on will
automatically load the next time you start MASCHINE.

Recording Audio

Prefer Project Folder If this checkbox is marked, the Samples you record will be put
in a subdirectory of the folder where your Project is saved. If
not, your recordings will be saved in the generic Recordings
folder in your standard user directory (see section 12.6.4,
Preferences — Default Page).

Clock Offset Depending on variables such as the speed of your CPU, your
audio interface, your MIDI interface and the Latency value you
selected in the Audio and MIDI Settings panel, you may
experience a lack of synchronization between MASCHINE and
the external MIDI Master. To compensate, you can adjust this
Clock Offset value. An easy way to do that is to play a 4/4 kick
drum pattern or a metronome sound on both MASCHINE and
the external MIDI Master and mix them together moving the
slider until they are played at exactly the same time. As soon as
you can hear a flanger-like effect, you know you are close to the
correct Sync Offset value. Keep on adjusting the Sync Offset
control until you can neither hear the flanging effect nor two
separate signals.
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Default MIDI Input Mode

MASCHINE lets you play your Sound(s) via MIDI notes, for
example, from a MIDI keyboard. By default and without any
configuration, incoming MIDI notes on any MIDI port and any
MIDI channel will trigger the pitch of the focused Sound. In
addition, you can select that a Sound receives no MIDI input,
and also define the default setting for MIDI input by selecting
the Default MIDI Input Mode preference. The following default
MIDI input mode options are:

Focus: MIDI input from any connected controller can be used to
trigger the focused (selected) Sound slot.
None: The selected Sound will not receive MIDI data.

Metronome

Enabled

Check this box to activate the metronome. You can also enable
the metronome by clicking the Metronome button in the
MASCHINE Header — see section Using the Metronome.

Auto-Enable when
Recording

Auto-Enable option automatically turns on the metronome when
you start recording a Pattern. When you start recording a Pattern
(typically by pressing REC on your controller), the metronome is
automatically enabled. When you exit recording (e.g., by
pressing the lit REC button) the metronome returns to its state
before the recording (this can be on or off).

The Auto-Enable option can be activated/deactivated both in the
software and from your controller.

The Auto-Enable option does not affect the Count-in: Even if
Auto-Enable is disabled, the metronome turns on when you
press SHIFT + REC to start the Count-in. For more information
on the Count-in, please refer to section 7.2.4 “Recording with
Count-in” in the MASCHINE 2.0 Manual.

Volume

Adjusts the volume of the metronome.
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Signature

Selects the time interval between each tick of the metronome.
By default the metronome indicates the beats (the quarter
notes, 1/4). Here you can select another note value for the ticks.

Count-in Length

Adjusts the duration of the Count-in, i.e. how long the
metronome will sound before the recording actually starts.

Input

Quantize

The Input Quantization setting can be set to one of the following
modes:

None: Input Quantization is disabled. Events you play or record
on the pads are not quantized.

Record: Input Quantization is applied only when you record the
pads.

Play/Rec: Input Quantization is applied both when you play on
the pads and when you record them.

In Play/Rec mode the quantization applied while playing is
slightly different from the quantization applied while recording:
When recording, all events are quantized to the closest step —
possibly ahead of the event. When playing, on the other hand,
events occurring in the first half of the steps are left untouched
(since you cannot bring them forward in the timeline!) whereas
events occurring in the second half of the steps are quantized to
the next step.

2.6.1.1  Usage Data Tracking

Usage Data Tracking technology enables MASCHINE to automatically track anonymous usage

data that you can choose to share with us.

Usage Data Tracking can be enabled or disabled in the General page of the Preferences in the
MASCHINE software. However, we encourage all users to keep Data Tracking enabled as it pro-
vides a valuable tool for understanding the performance of Native Instruments applications
when they are used in real life situations. The data sent to Native Instruments is one hundred

percent anonymous and will not affect performance.
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For more detailed information about Usage Data Tracking, please refer to the following Knowl-
edge Base article on the Native Instruments website:
https://support.native-instruments.com/hc/en-us/articles/209545029

To enable or disable Usage Tracking:

1. Open the General page of the Preferences by clicking Preferences... in the Maschine
menu (Mac OS X) or File menu (Windows) of the Application Menu Bar, or in the File sub-
menu of the MASCHINE menu.

2. Click the Allow usage data tracking checkbox to enable or disable user data tracking.

Preferences

General Startup

Reload Last Projec
Recording Audio

Prefer Project Folder
Metronome

Enabled

Auto-Enable when Recordir

Input

Usage Data Tracking

Read more

Usage Data Tracking in the MASCHINE Preferences.

2.6.2 Preferences — Audio Page
The Audio page holds settings related to your audio interface.

The Routing section allows you to configure the connections between the virtual inputs/outputs
of MASCHINE and the physical inputs/outputs of your audio interface.
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» To display the Audio page click the Audio tab on the left of the Preferences panel.

Preferences

Interface
Driver ASIO
Davice Traktor Audio 10
Running
44100
Open Panel
Latency Input:10.3ms Processing:5.8ms Output:6.3ms Total::

Routings

4 04 4 4 4 4 44

I
I
I
I
L
I
I
I
I

Close

Preferences — Audio page.

Setting Description

Interface

Driver

Select your audio driver here.
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Device This allows you to choose from the available devices if you have
connected more than one audio interface.
Status This shows you whether your audio interface is currently

running.

Sample Rate

This displays the selected sample rate of your audio interface.
Please restart MASCHINE after changing the sample rate.

ASIO Config (Windows only)

Click Open Panel to access specific controls related to your
Soundcard. Please consult the documentation that came with
your Soundcard for more information.

Latency

Mac 0S X: This slider allows you to adjust the latency of your
audio interface in samples. Lower values result in a more
immediate playing response but are heavier on both the CPU

and the audio driver, and may result in audible clicks and pops.

Larger values are easier on the CPU, but introduce a larger
latency (i.e., there may be a very small delay between when you
hit a pad and when you actually hear it). You should therefore
experiment with this setting so that it is as low as possible

without overloading your CPU or introducing any audio artifacts.

Windows: When using an ASIO driver, the Audio and MIDI
Settings panel shows an ASIO Config button instead of the
Latency slider. Click this button to open the settings window of
the selected ASIO driver.

Routing
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Inputs By clicking Inputs, you can define which inputs on your audio
interface should be used for the four stereo inputs of
MASCHINE. Select the inputs of your audio interface on the
right column by clicking the fields: you will be presented with a
drop-down menu with all the available Inputs. The choices
made here will determine which inputs can be used when
sampling external sources, for example.

Outputs By clicking Outputs, you will be presented with a list of the 16
stereo outputs from MASCHINE: In the right column, you can
assign them to the outputs of your audio interface. Click the
fields in the right column to select the desired outputs via a
drop-down menu.

2.6.3  Preferences — MIDI Page

The MIDI page allows you to set up the MIDI input and output ports that you want to use with
MASCHINE.

» To display the MIDI page click the MIDI tab on the left of the Preferences panel.
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Preferences

Sync
Made

Devices

Name

Close

The Preferences — MIDI page.
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Sync

Mode

Off: No MIDI sync mode is selected.

Master (Send Clock): If MASCHINE is running as a stand-alone
application, it can also send a MIDI Clock signal to any device that
is capable of receiving MIDI Clock. This could be hardware such as
a drum machine, another groovebox, or even another software
sequencer.

Slave (Receive Clock): If MASCHINE is running as a stand-alone
application, it can be controlled externally via MIDI Clock by any
device that is capable of sending MIDI Clock. This could be
hardware such as a drum machine, another groovebox or sequencer,
or even another software sequencer.

Please note that the Slave (Receive Clock) option is not available
when LINK is active. For more information on Link see 12.7,
Syncing MASCHINE using Ableton Link.

Clock Offset (appears
when Mode is set to
Slave)

Use the Clock Offset control to compensate delay that may occur
during MIDI data transmission. Delayed MIDI Clock data will cause
external devices to respond too late, thus making your track sound
out of sync.

By adjusting the Clock Offset value you can set an amount of
latency to be compensated (in milliseconds). MASCHINE will then
send MIDI Clock events ahead of time as defined.

Devices
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Setting Description

Inputs Clicking Inputs displays a list of all the available MIDI inputs of
your system. You can activate/deactivate each input by clicking the
fields in the Status column, which displays the current status of the
corresponding port.

Outputs Clicking Outputs displays a list of all the available MIDI outputs of
your system. You can activate/deactivate each output by clicking
the fields in the Status column, which displays the current status of
the corresponding port.

If you want MASCHINE to send other MIDI messages than MIDI Clock, in particular if
you want to control other MIDI-capable devices via the notes played in MASCHINE,
please refer to section 17.2.5, Sending MIDI from Sounds.

2.6.4 Preferences — Default Page

The Default page allows you to define a few default settings that will be used for every new
Project.

» To display the Default page click the Default tab on the left of the Preferences panel.
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Preferences

Project
Standalone Template
Plug-in Template
Metronome
Down Beat Sample
Up Beat Sample
Scene

Duplicate

Link when Duplicat
Pattern

Lengtt

Sound

Default MIDI Input Mode

Close

The Preferences — Default page.
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Setting Description

Project

Standalone

Here you can select a Project to load automatically when you
start a new Project in MASCHINE used as a stand-alone
application. The field displays the location of the Template
Project selected for use. Click the folder icon to select another
Template Project. Any Project file can be used as a template,
this can be from the MASCHINE Library or you could create a
file, for example with your preferred instruments and effects
already loaded into the Plug-in slots. If you have already set a
Template Project, click the cross icon to unset it and start new
Projects from scratch instead.

Plug-in

Here you can select a Project to load automatically when
MASCHINE is used as a plug-in within a Digital Audio
Workstation. The field displays the location of the Template
Project selected for use. Click the folder icon to select another
Template Project. Any Project file can be used as a template,
this can be from the MASCHINE Library or you can create a file,
for example with your preferred instruments and effects loaded
into the Plug-in slots. If you have already set a Template
Project, click the cross icon to unset it and start new Projects
from scratch instead.

Sounds

Default MIDI Input Mode

Metronome Settings

Down Beat Sample and Up
Beat Sample

Here you can select audio files to be used as up and down beat
of the metronome, respectively. The fields display the locations
of the audio files selected for use. Click the fields to select
other files. Click the little crosses on the right of the fields to
remove the custom audio files and use the default metronome
sounds instead.

Scene
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Setting Description

Duplicate

Scene Only

Only the Scene is duplicated. The result is a new unlinked
Scene with the same Patterns referenced.

Scene and Patterns

The Scene itself and additionally all Patterns are duplicated.
The new Scene and Patterns are now completely independent
from the originals.

Link when Duplicating

When enabled, the Duplicate command will create a linked copy
of a Scene. A linked copy will automatically be updated when
any instance of a linked Scene is edited. This way, you don’t
need to keep track of which Scene is the “original.”

By default this feature is disabled. Click the check box to
enable Link when Duplicating.

Pattern Length

Bars

Here you can define the default length of new Patterns. The
length is measured in bars:beats:16ths. To adjust the value,
click the desired number (bars, beats or 16ths) and drag your
mouse vertically. See 16.1.6, Adjusting the Pattern Grid and the
Pattern Length for more information on the Pattern Length.

2.6.5 Preferences — Library Page

The Library page allows you to edit the locations of all MASCHINE library files (both factory

and user) that appear in the LIBRARY pane of the Browser.

The LIBRARY pane of the Browser is described in section 13.2, Searching and Loading

Files from the Library.

» To display the Library page click the Library tab on the left of the Preferences panel.
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At the top of the page, the Factory and User buttons allow you to switch between the Factory
pane and the User pane.

Factory Pane

» To display the Factory pane, click the Factory button at the top of the Library page.

Preferences

Produc

ntshDriver
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The Preferences panel — the Library page’s Factory pane.
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The Factory pane shows all factory libraries available. These includes the MASCHINE Factory
Library, libraries imported from other NI products, as well as installed MASCHINE EXPAN-

SIONS.
These libraries will appear in the Factory view of the Browser’s Library pane.

Element Description

Location column Shows the path of each library. If you have moved any library to
another location on your computer, click the folder icon on the left of
that library and select its new path.

Product column Shows the name of each product. These names cannot be edited.

Rescan button If you have made any change to a library (e.g., changed its location),
select it in the list and click the Rescan button to rescan that library.

User Pane
» To display the User pane, click the User button at the top of the Library page.
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Preferences

Plug-in

STPlugins',

Rescan

Close

The Preferences panel — the Library page’s User pane.

The User pane shows all user libraries currently used. These include MASCHINE's standard
user directory as well as any other user directory you might have defined. These libraries will
appear in the User view of the Browser’s Library pane.
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Element Description

[ocation column

Shows the path of each library. If you have moved any library to
another location on your computer, click the folder icon on the left of
that library and select its new path.

Alias column

Shows the alias stored for each library. Click an alias to edit it.
Defining aliases for your user folders is not mandatory, but it can be
of great help when working on different computers (see description
below). After adding a location (see Add below), click the field in the
new row and in the Alias column to set the alias for that new
location. The alias of the default user folder, Standard User
Directory, cannot be edited — this is the location where all your user
files will be stored by default.

Add button

Click Add to manually add directories to the user library. See below
for more details.

Remove button

Click Remove to remove the selected user library. Files will only be
removed from the MASCHINE Browser, not from your hard disk.

Rescan button

If you have made any change to a library (e.g., added/removed files),
select it in the list and click the Rescan button to rescan that library.

Scan user content for
changes at start-up
checkbox

Click this checkbox to allow MASCHINE to scan for changes to the
User content directory during start-up.

You can resize the Preferences panel at your convenience using the usual method on
your operating system. You can also resize each column by clicking and dragging the
limit between both column headers.

User Content Folder Included in MASCHINE’s User Paths

Products from Native Instruments will store user-generated content in a centralized User Con-
tent folder. In MASCHINE this User Content folder is automatically added to the list of user
directories in the User pane of the Library page in the Preferences panel, and as a conse-

quence its files are available in the MASCHINE Browser.
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The User Content folder can neither be renamed nor removed from the list. You can modify its
path in the Location column.

Standard User Directory Cannot Be Removed

The Standard User Directory can neither be renamed nor removed from the list in the User
pane of the Library page in the Preferences panel. You can modify its path in the Location col-
umn.

Cancelling Library Rescan

In the Library page of the Preferences panel, the Rescan button allows you to rescan the se-
lected library (or all your libraries if none is selected) so that the MASCHINE Browser mirrors
any changes you have made to the files. Clicking this Rescan button triggers the scan and an
Updating Database dialog shows you the progress of the scan.

The Updating Database dialog includes a CANCEL button allowing you to interrupt the scan-
ning process without harming the database permanently:

Updating Database

18556 items found ...
Currently scanning FM8 (7 of 40)

The Updating Database dialog now includes a Cancel button.

Preferences
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1. Click CANCEL in the Updating Database dialog to interrupt the scan.
A Cancel Rescan dialog opens up asking you to confirm that you want to cancel the scan:

Cancel Rescan

Canceling a rescan process may lead to
inconsistencies or missing items in the Library.

CONTINUE  CAMNCEL RESCAN

The dialog warns you that cancelling the scan may lead to inconsistencies or missing
items in your MASCHINE Library.

2. If you still want to cancel the scan, click CANCEL RESCAN at the bottom right, and the
scan will be cancelled.

3. If you prefer instead not to cancel the scan, click CONTINUE or press [Esc] on your com-
puter keyboard, and the scan will go on.

If you cancelled the scan, any inconsistencies or missing items in your MASCHINE Library will
be solved by rescanning the same path(s) again (via the Rescan button mentioned above).

In opposition to the rescan process described here, you cannot cancel the import of files
into the MASCHINE Library (via the FILES pane of the Browser or via the Library page of
the Preferences panel) nor the process of applying changes to the file tags and proper-
ties (via the Attribute Editor in the Browser).

Using Aliases

The aliases available in the Alias column act as references to the paths shown in the Location
column. When you save a Project, the saved data includes both the path and the alias for each
file used in the Project. This will allow you to use a Project on different computers even if the
files used in the Project (e.g., Samples) are stored in different locations on each computer:
Simply define the same alias for these locations on each computer, and MASCHINE will re-
place the path saved on the first computer with the path set to the same alias on the second
computer in order to retrieve the files on this second computer, therefore avoiding the possibil-
ity of missing Samples.
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Adding Folders to the User Library

In the User pane of the Library page, you can add other folders to the user content of your MA-
SCHINE Library. To do this:

1. Click Add at the bottom of the pane.
A folder selection dialog opens up.

2. In the dialog, navigate to the desired folder on your computer and click OK (Choose on
Mac OS X).

—  All MASCHINE-compatible files found in the selected folder are added to your user con-
tent in MASCHINE.

Furthermore, the imported files will have their attributes (product/bank/sub-bank, Type/Sub-
Type/Mode tags, as well as properties) set as follows:

= For all file types, any attributes already in the files will be retained.

= For Samples, if the product/bank/sub-bank attributes are empty, they will be set to the
folders in which the Samples are located:

o The product will be set to the name of the folder you have selected.

o If Samples reside in a subfolder of this folder, the subfolder name will be used as
bank.

o |f Samples reside in a subfolder of this subfolder, the name of the lower subfolder will
be used as sub-bank.

By adding a folder to the user content of your MASCHINE Library, you make their files availa-
ble in the Browser’s LIBRARY pane for quick searching and loading! For more information on
how to use the LIBRARY pane of the Browser, please refer to section 13.2, Searching and
Loading Files from the Library.

Paths to folders added via the IMPORT button in the Browser’'s FILES pane will also
show up here. The only difference between adding folders via the Add button in Prefer-
ences panel, described here, and via the IMPORT button in the FILES pane of the
Browser is that the latter allows you to directly tag the files as they are imported. See
section 13.6.5, Using the Result List for more information on how to import folders via
the FILES pane.

Preferences
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Please note that the selected folder cannot contain, or be contained within, a folder already
listed in the User or Factory pane. If MASCHINE detects such a folder as you press OK
(Choose on Mac OS X) in the folder selection dialog, a Duplicate Location message appears:
Click OK to return to the folder selection dialog and select another folder on your computer.
Removing Folders from the User Library

You can also remove any user folder from your Library — except the default user

2.6.6  Preferences — Plug-ins Page

The Plug-ins page allows you to manage the Native Instruments and External Plug-ins you want
to use in MASCHINE.

» To display the Plug-ins page click the Plug-ins tab on the left of the Preferences panel.
At the top of the page, the Manager and Locations buttons allow you to switch between the
Manager pane and the Locations pane.

Manager Pane

» To display the Manager pane, click the Manager button at the top of the Plug-ins page.

In the Manager pane of the Plug-ins page, you can enable/disable VST/AU plug-ins, rescan
their directories, and set default presets for your Native Instruments and External Plug-ins.

When a Native Instruments or External Plug-in is disabled, it will not be available for loading
(from the various Plug-in menus in the software and from the Plug-in Browser on your control-
ler). If, for example, you do not use certain VST plug-ins in MASCHINE, it could be useful to
disable them so that they do not overload the list of available Plug-ins.

For more information on Native Instruments Plug-ins, External Plug-ins, and other Plug-
ins in MASCHINE, please refer to chapter 15, Working with Plug-ins.
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The Preferences panel — the Plug-ins page’s Manager pane.
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Element Description

Plug-in column

Lists all available VST/AU plug-ins from the directories specified in
the Locations pane (see below). This includes all enabled or disabled
32-bit VST/AU plug-ins, when MASCHINE is running in 32-bit mode
or otherwise all enabled or disabled VST/AU 64-bit plug-ins, when
MASCHINE is running in 64-bit mode.

On the left of each plug-in in the list, a checkbox allows you to
enable/disable this plug-in in MASCHINE. When a plug-in is disabled,
it will not be available for loading in MASCHINE.

Default Config column

For each plug-in you can set a default preset that will be loaded with
this plug-in when you load it. Click the folder icon on the left to
choose a default plug-in preset. You can also save a preset as default
for the Plug-in via the Save As Default... entry in the Plug-in menu. If
no default is set here, the parameters of this plug-in will be auto-
mapped when loading it into a plug-in slot.

To remove a default plug-in preset, click the little cross on the right.

Rescan button

If you have changed the content of any directory specified in the
Locations pane (see below), you should rescan your plug-in
directories in order to keep the list of available external plug-ins up to
date. Clicking Rescan will check the integrity of your plug-ins and
allow you to automatically detect plug-ins that were added or
removed, or deselect any plug-ins that are not working correctly for
any reason. Note that the scan will ignore the plug-ins that are
disabled in the list above.

Always Use Latest
Version of NI Plug-Ins
checkbox

The option to Always Use Latest Version of NI Plug-Ins selects
whether or not your Library content is always loaded with the latest
version of the associated plug-in. If this option is disabled, your
Library content is loaded with the lowest required version of the
associated plug-in found on the computer.
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Manager Pane: Use NI Audio Units Checkbox (Mac 0S X Only)

On Mac OS X, the Manager pane contains an additional Use NI Audio Units checkbox. Check
this box to include the Audio Units (AU) versions of your Native Instruments plug-ins in the
software’s Plug-in menus and in the controller’s Plug-in Browser:

= If this checkbox is disabled (default setting), the AU versions of your Native Instruments
plug-ins are still listed in the list above but they are disabled (checkbox unchecked): These
Plug-ins won't appear in the Native Instruments submenu of the Plug-in menus (software)
or in the Plug-in Browser (controller). Additionally, the remaining entries for Native Instru-
ments Plug-ins (all of them VST) won’t display the (VST) mention next to their name.

= If you enable the Use NI Audio Units checkbox, all Native Instruments’ AU plug-ins are en-
abled in the list above and are available for loading in MASCHINE. In order to distinguish
them from the VST versions, Plug-in entries in the Native Instruments submenu of the
Plug-in menus and in the Plug-in Browser will display either (VST) or (AU) after their name.

You can also enable or disable Native Instruments’ AU plug-ins individually in the list via the
checkboxes described above — as soon as you enable one of them, the Use NI Audio Units
checkbox is automatically activated.

The Use NI Audio Units checkbox relates only to AU plug-ins from Native Instruments.
AU plug-ins from third-party manufacturers are not affected by this setting.

When the Use NI Audio Units checkbox is disabled or the AU version of a Native Instru-
ments plug-in is disabled, you can still load Projects that use AU plug-ins.

Location Pane

» To display the Location pane, click the Location button at the top of the Plug-ins page.

In the Locations section of the Plug-ins page, you can manage the various plug-in directories
you want to use in MASCHINE.
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Preferences

Rescan

Close

The Preferences panel — the Plug-ins page’s Locations pane.

The Locations pane also contains the following controls:

Element Description

Plug-in column Lists all plug-in directories used in MASCHINE. Click the folder icon
on the left of an entry to change the path of that plug-in directory.
Add button Click Add to add plug-in directories.
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Element Description

Remove button

Click Remove to remove the selected directory.

Rescan button

If you have changed the content of a directory (such as installed or
removed plug-ins), you should rescan your plug-in directories in order
to keep the list of available plug-ins up to date. Clicking Rescan will
check the integrity of your plug-ins and allow you to automatically
detect plug-ins that are added or removed, or disable any plug-ins

that are not working correctly for any reason.

2.6.7 Preferences — Hardware Page

The Hardware page enables you to customize how the pads react to your playing and to adjust
the brightness of the displays.

» To display the Hardware page click the Hardware tab on the left of the Preferences panel.

MASCHINE 2 - Manual - 75



Basic Concepts

Preferences

Preferences

MASCHINE MK2

Display

Brightness

The Preferences panel — Hardware page.

2.6.8  Controller Menu in the Hardware Page of the Preferences Panel

In previous MASCHINE versions you could have only one device focused on a particular MA-
SCHINE instance, and the Hardware page of the Preferences panel showed the settings for
that particular controller. With the integration of the KOMPLETE KONTROL S-SERIES key-
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boards in MASCHINE 2.2, you can have two devices simultaneously focused on a MASCHINE
instance: a controller from the MASCHINE family and a KOMPLETE KONTROL S-SERIES key-
board.

For this reason, the Hardware page of the Preferences panel provides you with a new Controller
menu at the top allowing you to select the device of which you want to see and modify the set-
tings:

Preferences

Controller MASCHINE STUDIO v

Pads MASCHINE STUDIO
KOMPLETE KONTROL 549
lNouch Sensitivity k

Velocity Scaling Soft3 v
Display

Brightnass

Touch-Sensitive Knobs

The Controller menu allows you to display the settings for the desired device.

This menu can hold up to two entries, depending on the device(s) focused on that MASCHINE
instance:

= No device focused on that instance: The Controller menu is empty and all settings in the
Hardware page are grayed out and inactive. To modify the settings of a device from that
MASCHINE instance, the device must be connected to your computer and focused on that
instance.

= One device (MASCHINE or KOMPLETE KONTROL S-SERIES) focused on that instance:
The Controller menu holds only one entry for that device. This entry is always selected and
you can adjust the settings for that device.

= Two devices (one controller from the MASCHINE family and one KOMPLETE KONTROL S-
SERIES keyboard) focused on that instance: The Controller menu holds an entry for each
focused device and you can choose which settings you want to edit.
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» When two devices are focused on the MASCHINE instance, click the Controller menu at
the top of the Hardware page in the Preferences panel and select the particular device of
which you want to edit the settings.

—  Upon your selection all settings underneath are updated accordingly.

2.6.9 Preferences — Colors Page

The Colors page enables you to choose default colors for your Scenes, Groups, and Sounds.

» To display the Colors page click the Colors tab on the left of the Preferences panel.
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Hl White
M Auto

[E Use Group Color

Close

The Preferences panel — Colors page.
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Setting Description

Scene Default

Selects a default color for your Scenes. In the menu you can
choose the desired color from the 16-color palette or White
(default setting). The color selected as default is highlighted in
the menu. If you select Auto each Scene will have a different
default color.

Group Default

Selects a default color for your Groups. In the menu you can
choose the desired color from the 16-color palette. The color
selected as default is highlighted in the menu. If you select
Auto (default setting) each Group will have a different default
color.

Sound Default

Selects a default color for your Sounds. In the menu you can
choose the desired color from the 16-color palette. The color
selected as default is highlighted in the menu. If you select
Auto each Sound will have a different default color. If you select
Use Group Color (default setting) Sounds will by default mirror
the color of the Group they belong to.

Load with Colors

Color settings are saved with your MASCHINE files (Projects,
Groups, Sounds, etc.). If you uncheck Load with Colors
(checked by default), the saved colors won’t be used next time
you load the files — the loaded files will use the default colors
set in this Colors page instead.

Please note that the settings in this Colors page define default colors: These colors will
only be used when creating a new Project, resetting a Group/Sound, or when Load with
Colors is unchecked (see above). To change the color of particular objects (Sounds,
Groups, Patterns, Scenes) in your Project, use the Color submenu in the object’s context
menu in the software. See 14.2.4, Changing the Sound’s Color, 14.3.4, Changing the
Group’s Color, 16.6.7, Changing the Pattern’s Color, and 112.2.7, Changing the Scene’s
Color for more information, respectively.

As long as an object (Scene, Sound, Group or Pattern) has the default color, this color is
not attached to the object but instead to its “position” in the respective list: In particu-
lar, if you move the object to another position the default color will not follow the object
— the object will instead take the default color of its new position.
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2.1  Syncing MASCHINE using Ableton Link

Ableton Link is a protocol that synchronizes beat, phase and tempo of Link-enabled applica-
tions on the same computer or over a shared network. This means you can conveniently keep
applications synchronized across different devices or join a group jam with others with minimal
setup. Connecting applications via Link provides you with the ability to synchronize them to a
shared timeline and change the tempo globally from each of the connected applications.

2.1.1  Connecting to a Network

Applications that support Ableton Link can join a Link session when connected to the same
network. To enable Link within MASCHINE, simply make sure the computer running MA-
SCHINE is connected to the same local network as the other applications you want to link to.
This can either be a local network or an ad-hoc (computer-to-computer) connection.

To ensure maximum security and reliability while using Link, there are several things you may
want to consider:

= For reliability, connect to the local network using a router via an Ethernet cable.

= |f you do use a Wi-Fi network, be sure to use a password to prevent excluded users from
joining your session.

= For the most secure and reliable connection, create a Link session via a direct connection
from one computer to another using a Thunderbolt or Ethernet cable.

For more general information on setting up and using Link, please refer to the Link FAQs arti-
cle located on the Ableton website:

https://help.ableton.com/hc/en-us/articles/209776125-Link-FAQs.

2.1.2  Joining and Leaving a Link Session

It is possible to join a Link session at any time by clicking the LINK button. When another
Link-enabled application is connected, a moving bar within the LINK button is displayed even
though MASCHINE's transport is not running. This bar represents the global phase of Link that
all participating applications lock into.
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After clicking the Play button, playback will resume on the downbeat once the moving bar
within the LINK button is filled. The first participant to join the session sets the initial tempo,
from then on any participant in the session can change the tempo in their respective applica-
tion. If multiple participants change the tempo at the same time, the last tempo change will
take effect.

To start or join a Link session, proceed as follows:
1. Click the LINK button located in the header.

M > o =)

Intro 1

= MASCHINE will either join an existing Link session or begin a new session.
2. Start MASCHINE's playback by clicking the play button.

=  MASCHINE's playback is now synchronized with the Link timeline.

3. To stop using Link, and leave the session, click LINK again.

While connected, the LINK button displays how many other Link-enabled applications are con-
nected via Link. The example below indicates that there are two other applications connected.

120.00

Active Link session with two other instances connected.
When Link is active, it is not possible to synchronize MASCHINE to incoming MIDI

Clock as a slave. Link will take priority. Sending MIDI Clock from MASCHINE as a mas-
ter is still possible.
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3 Browser

The Browser is the place where you can organize and categorize all of your Projects, Groups,
Sounds, Plug-in presets, and Samples. This is done by tagging them, which means categoriz-
ing them by using keywords. Given that the MASCHINE software has some advantages over the
hardware in this case, such as a very big screen and a QWERTY-keyboard, we will start with the
software first.

3.1 Browser Basics

This section describes some general concepts about the Browser.

3.1.1  The MASCHINE Library

To organize, find, keep track of, and provide you thousands of files at any time ready for load-
ing, MASCHINE makes use of a Library. The MASCHINE Library not only contains the factory
content included with MASCHINE, but also any other factory content (e.g., from MASCHINE
EXPANSIONS or other Native Instruments products) as well as your own user content.

To help you find the right file quickly and efficiently, the Library implements various techni-
ques that go far beyond the classic folder structure of your operating system. For example,
each file included in the Library can be described according to following aspects:

= The file type: Project, Group, Sound, etc.

= The content type of the file, i.e. whether it originates from a product’s factory library or if it
was created by a user.

= The product which the files comes from — this can include, e.g., a hierarchical structure
with a product category, a particular product, and possibly a bank and sub-bank of this
product.

= A variable amount of tags used to describe various characteristics of the file, for example,
the type of effect, the sonic character, the context in which it is used — in a word, any-
thing that might help you find the file.
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Note that the Library is the only other way to display and access your files: You could
also navigate to the same files in your file system. The (substantial) difference lies in
the fact that the Library organizes your files in a musically relevant way.

Which Files are Included in the MASCHINE Library?

The files included in the MASCHINE Library are all MASCHINE-relevant files found in the fold-
ers whose paths are listed in the Library page of the Preferences panel. For more information
on how to manage these library folders, please refer to 12.6.4, Preferences — Default Page.

3.1.2  Browsing the Library vs. Browsing Your Hard Disks

The Browser is your interface to the MASCHINE Library. It provides all necessary tools to
search for the files you require — and suggest other files you might not have thought of. Be-
side this, the Browser also allows you to navigate your file system in a classic way. Both are
described in the next section.

The Browser provides two operation modes, each of them providing its own tools:

= The LIBRARY pane allows you to browse the MASCHINE Library. This is the preferred way
to search for files meeting particular musical requirements. This pane also allows you to
tag your own files to your liking.

= The FILES pane allows you to browse your hard disks by using the hierarchical folder struc-
ture of your operating system. For example you can use it to navigate files that have not
been imported into the MASCHINE Library — and you can import them from there!

In contrast to the software, the Browser on your controller can only load files that have
already been added to the Library. You cannot directly access specific directories on

your hard disks with the Browser using the controller. This is why you should always im-
port all your files to the Library and tag them using the software beforehand.

Switching Between LIBRARY and FILES Pane

» To show the LIBRARY pane or the FILES pane of the Browser, click the corresponding
tab at the top of the Browser.
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LIBRARY

All Projects

Click the desired tab to show the corresponding pane of the Browser.

The LIBRARY pane is described in section 13.2, Searching and Loading Files from the Library,
and the FILES tab is described in section 13.6, Loading and Importing Files from Your File
System.

3.2  Searching and Loading Files from the Library

The Browser’s LIBRARY pane allows you to search for any file in the MASCHINE Library.

» To display the LIBRARY pane, click the LIBRARY tab in the top left corner of the Brows-
er.

3.2.1 Overview of the LIBRARY Pane

The LIBRARY pane contains following elements:
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M

All Instruments

- TYPES

The elements of the LIBRARY pane.

(1) LIBRARY tab: Click the LIBRARY tab to open the LIBRARY pane described here.

(2) File Type selector: This contains six icons, each representing the different files types of MA-
SCHINE. From the left to right the file types are Project, Group, Sound, Instrument preset, Ef-
fect preset, and Sample. By clicking one of them it causes only the files of the selected type to
be displayed in the Result list (8). See section 13.2.4, Selecting a File Type.
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(3) Content selector: Click the NI icon (on the left) to select factory content or the User icon (on
the right) to select user content instead. Only the files of the content selected here will be dis-
played in the Result list (8). See section 13.2.5, Choosing Between Factory and User Content.

(4) Product selector: Click to open a drop-down menu where you can select a particular prod-
uct, product category, and sometimes the bank and sub-bank of the selected product. Again,
only the files matching your selection will be displayed in the Result list (8). See section
13.2.3, Selecting a Product Category, a Product, a Bank, and a Sub-Bank.

(5) TYPES filter: allows you to search for files based on Type and Sub-Type tags that have been
applied to them. See section 13.2.6, Selecting Type and Mode Tags.

(6) MODES filter (Instrument/Effect presets only): allows you to search for files based on Mode
tags that have been applied to them. See section 13.2.6, Selecting Type and Mode Tags.

(7) Search field: Enter any character string into the Search field to limit the search results to
the files containing this string. See section 13.2.7, Performing a Text Search.

(8) Result list: The Result list displays all files that match your query, as specified via the vari-
ous tools above. See section 13.2.8, Loading a File from the Result List.

(9) Control bar: At the bottom of the Browser, the Control bar provides a few useful tools when
browsing the MASCHINE Library, some of them depending on your selection in the File Type
selector (2):

= For all file types except Project, click the Autoload button at the far left of the Control bar to
automatically load the selected file in order to hear it in context with the rest of your
Project while it is playing. See section 13.3.1, Loading the Selected Files Automatically.

= For Samples, enable the Prehear button and adjust the volume fader next to it in order to
pre-listen to the selected Samples directly from the Browser in order to make a quick se-
lection. See section 13.3.2, Pre-Listening to Your Samples.

= For Groups, enable the Load Patterns checkbox to load the Group’s Patterns together with
the Group. See section 13.3.3, Loading Groups with their Patterns.

= For all files, click the Information button (showing a little “i”) near the EDIT button to dis-
play more information on the selected file(s). See section 13.3.4, Displaying File Informa-
tion.
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= For all files, click the EDIT button at the far right of the bar to open the Attribute Editor and
modify the tags and properties assigned to the selected file(s). See section 13.5, Editing
the Files’ Tags and Properties.

Overview of the Search Workflow in the LIBRARY Pane

When searching for files via the LIBRARY pane, you can progressively refine your search by fol-
lowing this typical top-to-bottom workflow.

The first two steps are mandatory:
1. Choose a file type in the File Type selector (2).
2. Select between factory content and user content in the Content selector (3).

The next steps are optional. They can be useful to further refine your search and limit the
number of search results to a reasonable amount:

1. Choose a product category or a product in the Product selector (4). If you have selected a
product you can further choose a particular bank and sub-bank of this product, if any.

2. Select tags in the TYPES filter (5) — and the MODES filter (6) for Instrument and Effect
presets — describing what you are looking for.

At any time in the procedure described above, you can use the Search field (7) to quickly per-
form a text search among the entries in the Result list (8).

The above steps are described in detail in the following sections.

3.2.2  Selecting or Loading a Product and Selecting a Bank from the Browser

The Product selector allows you to limit your search to a certain product category, a particular
product, or a specific bank of the product. You can also load a product along with its default
preset file directly from the Product selector (see below).

By default there is no particular selection in the Product selector; it reads All Instruments:
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© MASCHINE

LIBRARY

i

All Instruments

- TYPES

Drums Flute

Synth Lead Synth Misc  Synth Pad

The closed Product selector header.

Selecting a Product Category
» Click on the Product selector header to open it.

— The Product selector opens up, showing you all products available in your MASCHINE Li-
brary.
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LIBRARY

]

All Instruments

Category

AR 50s Drummer A AR 70s Drummer

AR Vint. Drum.

The opened Product selector.

(1) Product selector header: The header shows the selected product—if there is no selection it
shows a generic label (All Instruments). Click on the header to close the Product selector.

(2) Category/Vendor selector: Allows you to sort the Product list by Category or by Vendor.
(3) Product list: Shows all products that are available in your MASCHINE Library.

If Category is selected in the Category/Vendor selector, the Product list is sorted by the follow-
ing categories:

= Drums & Percussion
= Sampled Instruments
= Synthesizers

= Other

If Vendor is selected in the Category / Vendor selector, the Product list is sorted by the names
of the manufacturers.

» To select a product and show only the preset files associated with it, click on the product
in the list.
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— Upon your selection, the Product selector automatically closes, the product name and
icon appear in the header, and the tag filter and results list below will be filtered accord-

ingly.

Products are shown in the Product selector only if the Library contains files for them. If
a particular product does not show up, make sure that you have installed the latest up-
dates using Service Center.

Resetting the Product Selection

» To reset the selection made in the Product selector, click the little cross at the right of
the product name:

LIBRARY

[
POLVPLEX

All Banks

- TYPES

— The product selection is cancelled. The Product selector displays the generic label All In-
struments. The tag filter and the results list under the Product selector now include files
for all products.

Selecting a Bank

When you select specific products in the Product list (see description above), an additional
Bank menu appears under the closed Product selector:
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LIBRARY

]

POLVPLEX

All Banks

The Bank menu showing All Banks for POLYPLEX

The Bank menu allows you to select a particular bank of files for the selected product (POLY-
PLEX in the picture above).

Banks can be additional Libraries (for example MASSIVE Expansions), different versions of the
original Factory Library (for example FM7 Legacy and FM8 Factory Library), or any other con-

tent categorization specific to a particular product (for example different sets of drum sounds
for POLYPLEX, as shown above).

» To select a particular bank for the selected product, click the Bank menu under the prod-
uct icon and choose a bank from the available entries.

© MASCHINE

LIBRARY

iy
POLVPLEX

All Banks

— Upon your selection the Bank menu closes and displays the selected bank. The tag filter
and results list underneath further narrow their content accordingly.
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» As with the product selection, you can remove the selected bank by clicking the little
cross next to the bank name in the closed menu.

Loading a Product from the Product Selector

If you wish to not only filter the results list by selecting a product, but also load the product
along with its default preset file, you can do so directly from the Product selector.

» To load a product with its default preset file, place the mouse over the product entry in
the Product selector and click on the arrow symbol that appears in the upper right corner

— The product and the first preset from the results list for this product are loaded, and the
result list only displays preset files only associated with this product.

3.2.3  Selecting a Product Category, a Product, a Bank, and a Sub-Bank

The Product selector allows you to limit your search to a certain product category, a particular
product, a specific bank of the product, or even a sub-bank in this bank.

By default there is no particular selection in the Product selector: It reads All Projects, All
Groups, All Sounds, All Instruments, All Effects or All Samples according to the type of file
selected in the File Type selector above (see section 13.2.4, Selecting a File Type):

All Instruments

The closed Product selector without any Instrument selected.

Selecting a Product or a Product Category

» Click the Product selector to open it.
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— The Product selector opens up and shows you the following:

All Instruments

Category

L4

Absynth V8 Kontour
"

=1 A A

Monark Prism

-

The opened Product selector (for Instrument presets).

(1) Product selector header: The header shows the product or the selected product category —
if there is no selection it shows a generic label (All Instruments in the picture above) corre-
sponding to the type of file selected in the File Type selector above. Click the header to close
the Product selector.
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(2) Product Category filter: Shows the categories of the products that have files available in the
MASCHINE Library. Click a category of a product to select/deselect it. Selecting a category
l[imits the number of products shown in the Product list below (3). Only one category can be
selected at a time. You can also select a category and close the Product selector by clicking its
header (1) again: The header (1) will display the category that you have just selected, and the
TYPES filter (and MODES filter, if present) along with the Result list will be filtered by that
category.

(3) Product list: Shows the products for which files are available in the MASCHINE Library.
Click the desired product in the list. Upon your selection the Product selector automatically
closes, the product name and icon appear in the header, and the tag filter and Result list be-
low will be filtered accordingly.

MONARK

The closed Product selector with an Instrument selected.

Product categories and products are shown in the Product selector only if the MA-
SCHINE Library contains files for them. For example, if a Native Instruments effect from
the KOMPLETE family is installed on your computer but you haven’t saved any user pre-
sets for it in MASCHINE yet, its product icon will not be available in the Product selec-
tor when the user content is selected in the Content selector. Similarly, if you haven't
updated a particular Native Instruments effect/instrument, the icon for that product
might not be available in the Product selector when the factory content is selected in
the Content selector — to prevent this, make sure that all your Native Instruments prod-
ucts are up to date.

Resetting the Product Selection

» To reset the selection made in the Product selector, click the little cross at the right of
the product name:

MONARK
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— The product selection is cancelled. The Product selector displays the generic label corre-
sponding to the selected file type (Project, Group, Sound, Instrument preset, Effect pre-
set or Sample). The tag filter and the Result list under the Product selector now include
files for all products.

Selecting a Bank and a Sub-Bank

When you select specific products in the Product list (see description above), an additional
Bank menu appears under the closed Product selector:

&, REAKTOR

All Banks

The Bank menu showing All Banks for REAKTOR Effects.

This Bank menu allows you to select a particular bank of files for the selected product (MA-
SCHINE in the picture above).

» To select a particular bank for the selected product, click the Bank menu under the prod-
uct icon and choose a bank from the available entries.

&, REAKTOR

All Banks

— Upon your selection the Bank menu closes and displays the selected bank. The tag filter
and Result list underneath further narrow their content accordingly.

Banks can be, e.g., additional libraries (e.g., MASSIVE EXPANSIONS), different versions
of the original Factory Library (e.g., FM7 Legacy and FM8 Factory Library), or any other
content categorization specific to a particular product.
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Similarly, some banks are split into several sub-banks. In that case a Sub-Bank menu appears
under the Bank menu and allows you to select a particular sub-bank. For example, in the pic-
ture below the Grain Delay sub-bank of the Maschine 2.0 Library bank is selected for the MA-
SCHINE Effect presets:

© MASCHINE

Maschine 2.0 Library

Grain Delay

The Grain Delay sub-bank in the Maschine 2.0 Library bank.

As with the product above, you can remove the selected bank and sub-bank by clicking the lit-
tle cross at the right of the bank or sub-bank name in the closed menu.

Products and Banks for User Content

When you save your own MASCHINE files, they are automatically assigned to products, banks,
and sub-banks as follows:

= When you save Projects, Groups or Sounds, they are automatically set to the Maschine
product.

= When you save Instrument or Effect presets:

o Presets for Internal Plug-ins: The product is set to Maschine, while the bank is set to
the particular Internal Plug-in for which the preset has been saved (e.g., Sampler,
Kick, Flanger, etc.).

o Presets for Native Instruments Plug-ins: The product is set to the particular Native In-
struments effect or instrument. The bank and sub-bank will vary with each Native In-
struments product.

o Presets for External Plug-ins: The product is set to the manufacturer of the VST/AU
plug-in, and the bank is set to the particular VST/AU plug-in for which the preset has
been saved. The sub-bank is left empty. In addition, the preset is assigned to the Ex-
ternal Plug-ins product category.
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3.24  Selecting a File Type
The File Type selector shows six icons representing the different file types of MASCHINE:

The File Type selector.

(1) Project: (.mxprj)

(2) Groups: (.mxgrp)

(3) Sounds: (.mxsnd)

(4) Instrument Plug-in presets: (.mxinst)
(5) Effect Plug-in presets: (.mxfx)

(6) Samples: (.wav, .aiff)

» Click the desired icon in the File Type selector to display only the files of that type in the
Result list.

— The selected icon is highlighted and the files are filtered accordingly.

3.2.5  Choosing Between Factory and User Content

The Content selector shows two icons representing the factory content on the left, and the user
content on the right:

The Content selector.
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» Click the NI icon to search the factory content, or click the User icon to search the user
content.

3.26  Selecting Type and Mode Tags

The tag filter that appears under the Product selector allows you to search for files according to
particular characteristics, effect type, sonic character, etc.

Chord Dry Glide/Pitch Mod  Lor

TYPES and MODES filters for the Massive Threat bank of the MASSIVE Plug-in.

» Click the desired tags in the tag filter to select them and limit the search to the files
marked with them. Click the selected tags again to deselect them and broaden the
search.

Tags for Projects, Groups, Sounds, and Samples: 3 Type Levels

For Projects, Groups, Sounds, and Samples, tags are structured into three hierarchical levels
globally called Types. You can select them via the TYPES filter:

= At first the TYPES filter displays the available top-level tags only.

= As soon as you select a tag at the top level, the second level appears underneath with sub-
tags of the selected tag.
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= The hierarchical structure means that the sets of sub-tags are specific to each tag of the
level above.

Example: Imagine that you are looking for a shaker Sample from the MASCHINE factory library:

= You have already selected the Maschine product in the Product selector, and the Maschine
2.0 Library bank of this product (for more information on this, see section 13.2.3, Select-
ing a Product Category, a Product, a Bank, and a Sub-Bank). For now the TYPES filter
shows only top-level tags:

Maschine 2.0 Library

Drums Loops One Shots

= In order to find a shaker, you first select the Drums Type from the TYPES filter.
Upon your selection the second level of tags appears underneath:

Clap
Kick

In this second level, you select the Shaker Sub-Type.
Now the third level appears with Sub-Types like Acoustic, Analog, etc.

Clap
Kic

Acoustic  Analog  Digital  Vinyl
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By selecting any of these tags, say, Acoustic, you will narrow your search to this particular
Sub-Type of shakers:

Kick

Analog Digital

= Now imagine that you have loaded an acoustic shaker Sample and want to find a Sample
for another drum instrument, e.g., a tom: You leave the Drums tag selected at the top level
of the TYPES filter and directly go to the second level, where you select Tom instead of
Shaker. As you select Tom, the whole set of Sub-Types underneath (third level) will be re-
placed with the Sub-Types of the Tom tag. However, insofar as possible your previous se-
lection will be retained: In our example, both the Shaker and Tom tags have an Acoustic
tag below them; since you had selected the Acoustic tag below the Shaker tag, the Acous-
tic tag below the Tom tag will be automatically selected as well.

Analog Digital Human

This allows you to quickly find various Samples (even for different instruments) with similar
characteristics — here, an acoustic sound.

Tags for Instrument and Effect Presets: 2 Type Levels and 1 Mode Level

For Instrument and Effect presets, tags can be of two kinds: Type or Mode. You can select
them via the TYPES and MODES filter, respectively:

= The TYPES filter works as described above for all other file types, except that only two hier-
archical levels are available. See above for a detailed description.

= The MODES filter provides an additional level that is independent from the Type levels:
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o |n general, Mode tags will rather refer to technical terms (e.g., Arpeggiated, Percus-
sive, Synthetic, etc.).

o The MODES filter is always displayed. You can start your search with the MODES filter
before (or even without) using the TYPES filter.

o However, the list of tags available in the MODES filter will vary depending on the tags
selected in the TYPES filter. If no file contains both the Type and Mode tags that you
have selected, the Type tags will prevail and the Mode tags will be deselected.

If you don’t select any tag in the TYPES or the MODES filter, the Result list will include
all files satisfying any of their tags.

Selecting Multiple Tags from the Same Level
In both TYPES and MODES filter you can select multiple tags from the same level:

» Hold [Shift] on your computer keyboard and click two tags at a particular level to select
these tags and all tags in-between.

» Hold [Ctrl] ([(Cmd] on Mac OS X) on your computer keyboard and click any number of
tags at a particular level to select these particular tags.

— The Result list will include all files satisfying at least one of the selected tags.

Opening and Collapsing the Attributes Sections

The Attributes sections (TYPES and MODES) in the Browser Library can be collapsed to make
more room for the results list on smaller display resolutions.

To collapse the Attributes sections:
» Click the small triangle located to the left of the Attributes (TYPES or MODES).

— The Attribute sections will collapse results will be shown depending on the amount of
space available. Click the triangle again to reopen the sections.
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LIBRARY

[

All Instruments

5th Please

Sth Time Lucky

Highlighted triangle next to the Attributes (TYPES and MODES).

3.2.7  Performing a Text Search

In the Search field you can enter your search query.

The Search field.
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» Click in the Search field and type the desired text to limit the results to files containing
this text.

The search will be performed on the file paths, the file names, the products/banks/sub-banks,
the tags, and the properties directly as you type. If you want to search for a combination of two
words (e.g. “bass” and “analog”) just enter both words in the Search field with a space in be-
tween. As you start typing, the list of matches will start narrowing in the Result list below.

On the right of the Search field, click the Reset button (showing a little cross) to reset both text
search and tag search. The Product selection is not affected.

3.2.8  Loading a File from the Result List

The Result list shows all the files that match your query:

JuPop 2

JuPop 3
op 4

The Result list showing kicks from the MASCHINE Library.

If the list is too long to fit in the display, use your mouse wheel or drag the scroll bar on the
right to show the remaining items.

The Result list allows you to:
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= Select the desired file(s).

= Load the selected file(s) into your Project (or load another Project).
= Delete the selected file(s) from your hard disk and from the Library.
= Navigate to the selected file(s) in your operating system.

= See, and possibly edit, the attributes of the selected file(s) by clicking the EDIT button at
the bottom right of the Browser. For more information on this, please refer to section 13.5,
Editing the Files’ Tags and Properties.

Selecting Files in the Result List

» To select a single file in the Result list, click its entry.
You can also select multiple files in the Result list in order to process them all at once.

To select adjacent files in the list, do the following:

» Hold [Shift] on your computer keyboard and click two files in the Result list to select
these files and all files in-between.

To select distant files in the list, do the following:

» Hold [Ctrl] ([Cmd] on Mac OS X) and click all the files you want to select.

Loading Files via Double-Click

Double-clicking one of the matches will load the respective file. Depending on what file type
you have selected, the file will be loaded to different locations within MASCHINE:

= |f it is a Project it will load all associated files replacing all files currently in memory. If
your current Project contains unsaved changes a dialog will appear asking you if you want
to save them. This is to prevent you from losing changes by accidentally loading a new
Project without saving the old one.

= |If it is a Group, it will be loaded into the Group currently in focus.
= If it is a Sound, it will be loaded into the Sound slot currently in focus.

= If it is an Instrument preset, it will be loaded into the first Plug-in slot of the Sound slot
currently in focus.
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= |If it is an Effect preset, it will be loaded into the selected Plug-in slot.

= If it is a Sample, it will be loaded into the Sound slot currently in focus. The Sampler Plug-
in will be automatically loaded in the first Plug-in slot in order to play the Sample. The
Sample will spread over the entire velocity and note range.

The file loaded will replace the object previously at that position or in this slot, if any! If
needed, you can undo/redo your action via the shortcuts [Ctrl] + [ZI/[Y] (Windows) or
[Cmd] + [ZV/[Y] (Mac OS X).

Loading Files via Drag and Drop

Except for Projects, you can also load files from the Result list into the desired location via
drag and drop. This notably has the following benefits:

= You can load the file into a Group or a Sound slot that is not currently focused, or into a
Plug-in slot that is not selected.

= You can load a Sample into its own Zone in the Zone page of the Sample Editor: A new
Zone will be created for that Sample. See section 113.5.7, Adding Samples to the Sample
Map for more information.

Drag and drop of Groups and Sounds is possible only in Arrange view.

Loading Multiple Files at Once via Drag and Drop

Once you have selected multiple files from the Result list (see description above), you can drag
and drop them to the relevant locations in MASCHINE. By doing this, please keep in mind the
following:

= When dragging several Groups onto the Group List, you have following options:

o If you drop the Groups between two existing Groups (where the insertion line appears),
the dropped Groups will be inserted between these two Groups.

o |If you drop the Groups onto an existing Group, the dropped Groups will replace that
Group and the following ones.

o If you drop the Groups onto the “+” at the end of the Group List, the Groups will be
appended to the existing Groups in the Group List.
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= When dragging several Sounds, you have following options:

> |If you drop the Sounds onto an existing Group, the Sounds will be loaded in the empty
Sound slots of that Group — if there are not enough empty Sound slots, the Sounds
will be loaded in the first Sound slots of the Group, replacing the Sounds previously
loaded in these slots.

o |f you drop the Sounds onto the “+” at the end of the Group List, the Sounds will be
loaded in a new Group appended to the existing Groups.

o If you drop the Sounds onto the Sound List, the Sounds will be loaded in adjacent
Sound slots, starting from the slot onto which you dropped them.

= When dragging several Instrument presets, you have the same options as when dragging sev-
eral Sounds (see above). Each Instrument preset will be loaded into in its own Sound, and
the Sound will take the name of the preset.

= When dragging several Effect presets, you have following options:

o |f you drop the Effect presets onto a Group in the Group List or onto a Sound in the
Sound List, they will be appended to the existing Plug-ins in the Plug-in List of that
Group or Sound.

o |If you drop the Effect presets between two existing Plug-ins in the Plug-in List of any
channel, they will be inserted between these two Plug-ins.

o |f you drop the Effect presets onto an existing Plug-in in the Plug-in List of any chan-
nel, they will replace that Plug-in and the following ones.

= When dragging several Samples, you have following options:

o |If you drop the Samples onto an existing Group, onto the “+" at the end of the Group
List, or onto the Sound List, you have the same options as when dragging several
Sounds (see above). Each Sample will be loaded in its own Sound with a Sampler
Plug-in in the first Plug-in slot in order to play the Sample. The Sample will spread
over the entire velocity and note range.

> You can also drop the Samples onto the Zone page of the Sample Editor. In that case
all Samples will be loaded in the focused Sound and a Zone will be created for each
Sample. For more details, see section 113.5.7, Adding Samples to the Sample Map.
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You cannot load multiple Projects at once.

Drag and drop of Groups and Sounds is possible only in Arrange view.

Deleting Files in the Result List
You can delete user files directly from the Result list:

1. Right-click ([Ctrl]-click on Mac OS X) the desired user file and select Delete from the con-
text menu. If you want to delete several files at once, first select them as described
above, and right-click ([Ctrl]-click on Mac OS X) ([Ctrl]-click on Mac OS X) any of them.

A warning dialog opens to inform you that the file will be not only removed from the MA-
SCHINE Library but also deleted from your hard disk.

2. Click OK to confirm the deletion (or Cancel to keep the file).
— The file is deleted from the MASCHINE Library and from your hard disk.

When browsing factory content, the Delete entry is not available in the context menu.

Navigating to the Files in Your Operating System
If you want to find out the location of a particular file shown in the Result list, do the follow-
ing:

» Right-click ([Ctrll-click on Mac OS X) any file shown in the Result list and select Find in
Explorer (Find in Finder on Mac OS X) from the context menu to open an Explorer/Finder
window pointing to the folder containing that file on your operating system.

3.3  Additional Browsing Tools

At the bottom of the Browser, the Control bar provides various useful tools that will help you
quickly find and check the files you need.
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The Control bar at the bottom of the Browser.

Some of the tools are available only for specific file types. The next sections describe each of
these tools.

The EDIT button (LIBRARY pane) or IMPORT button (FILES pane) at the far right of the
Control bar allows you to edit the attributes of the files selected in the Result list above
(in the FILES pane, these are the files being imported to the Library, whereas in the
LIBRARY pane these are files already in the Library). Please refer to section 13.5, Edit-
ing the Files’ Tags and Properties for more information!

3.3.1  Loading the Selected Files Automatically

» Click the Autoload button to enable/disable Autoload.

The Autoload button.

When Autoload is enabled, any item that you select in the Result list of the LIBRARY pane or
FILES pane is automatically loaded into the focused Group or Sound slot or into the selected
Plug-in slot, replacing any content currently in that location. This allows you to listen to this
item in context with the rest of your Project while it is playing.

Autoload is not available when browsing Projects.

Autoload is not available when browsing Samples with Prehear enabled — see section
13.3.2, Pre-Listening to Your Samples.

@ Autoload is not only useful to look for an appropriate Sound, Group, Plug-in preset or
Sample, but can also be very inspiring: With a Pattern playing, browse through your Li-
brary with Autoload activated and listen to Sounds and Samples you normally would not

use in that context.
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3.3.2  Pre-Listening to Your Samples

When you are browsing Samples, a Prehear button and Prehear Volume slider appear next to
the Autoload button.

The Prehear controls.

» Click the Prehear button (showing a little speaker icon) to enable/disable Prehear.

When Prehear is enabled, you can directly hear Samples as you select them in the Result list
of the LIBRARY pane or FILES pane.

» Drag the Prehear Volume slider next to the Prehear button to adjust the volume of the
Samples you are pre-listening to.

The Prehear signal is sent to the Cue bus of MASCHINE. This allows you to pre-listen to Sam-
ples on a distinct output pair (e.g., in your headphones) without affecting MASCHINE's main
output! For more information on the Cue bus, see section 18.2.6, Using the Cue Bus.

@ Prehear is particularly useful on your controller! See below for more details.

Prehear and Autoload are mutually exclusive: Only one of them can be active at a time.
For more information on the Autoload feature, see section 13.3.1, Loading the Selected
Files Automatically.

3.3.3  Loading Groups with their Patterns

Every Group from the factory library includes a set of Patterns that illustrate possible uses of
that Group. Similarly, when you save a Group of your own to the Library for later use, all Pat-
terns you have created for that Group will be saved with the Group.

When browsing Groups, you can choose to load each Group with or without its Patterns. This is
done by clicking the Load Patterns button at the bottom of the Browser:
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The Load Patterns button.

= Load Patterns button enabled: Groups will be loaded together with their Patterns. This al-
lows you to use the Patterns you have saved with the Groups. Upon loading, all Patterns of
the focused Group will be replaced, and a Clip referencing the first Pattern will be created
in the selected Scene.

= Load Patterns button disabled: Groups will be loaded without their Patterns. This allows
you to load another set of Sounds while keeping your current Patterns. Notably, this can be
very useful to try another drum kit with your current Patterns!

The Load Patterns checkbox is available only when browsing Groups.

3.3.4  Displaying File Information

The Information button.

» Click the Information button (showing a little “i”) next to the EDIT button in the right
part of the Control bar to display information on the file(s) selected in the Result list.

— A box appears above with various information on the selected file(s): File Format, Date
modified, File Size, Type, as well as the Author and Vendor properties, if any (see section
13.5, Editing the Files’ Tags and Properties).
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File Form WAV File

D modified: 11/30/12 12:44:36

121.1 KB
Mative Instruments

Mative Instruments

The Information box provides various information on the selected file(s).

If the selected files have different characteristics, the corresponding fields in the Information
box will read multi.

3.4  Using Favorites in the Browser

Favorites in the MASCHINE browser allow you to quickly view and browse your most frequently
used items. This includes Projects, Groups, Sounds, Instrument presets, Effect presets, and
Samples. Any of these items can be assigned as a Favorite. The Favorites serve as an addition-
al filter in the Browser. When activated, the results list will only show items that have been
assigned as a Favorite, and also match all other selected filters, including the search query en-
tered into the search field. Favorites are available for both the factory content and the user
content.

Here are some important notes regarding the use of Favorites:

= Favorites are automatically shared across MASCHINE and KOMPLETE KONTROL browser
databases on one computer.

= Favorites are independent of the file's location: if a file is moved, it retains its favorite tag.

= Favorites are persistent: If a file location is rescanned or deleted and later added again to
the database, all files retain their favorite tags.
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- TYPES

» MODES Sound 1

Ego

Electrostatic Pulse

*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*

The MASCHINE Browser showing all Favorite Instruments tagged with the Type Bass.

To activate the Favorites filter:
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1. Click on the Filter Favorites control next to the search field to filter the results by Favor-
ites:

+ MODES

700 Dirt Bass

2. The Filter Favorites control is now lit and the results list shows all Favorites that match
the selected search criteria:

Bangkok

’ I
k'S

*
*
*
*
*
*
*
*
*
*

Adding an Item to the Favorites List
To add an item to the Favorites, follow the instructions below:

1. Place the mouse cursor over an entry in the results list to show the Set Favorite icon.
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All Jungle Massive

All Time

2. Click on the Set Favorite icon to add the corresponding item to the Favorites.

— The item is added to the Favorites, indicated by the lit Set Favorite icon next to its name:

ustigue
All About

All Jungle Massive

Almost M

Alpha Buzz
Alt B

@ You can add any item in the results list to the Favorites, no matter if it is selected or
not. The Set Favorites icon will appear as soon as you place the mouse cursor over the
entry.

Removing a Preset from the Favorites List

To remove a preset from the Favorites, follow the instructions below:
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1. Click on the lit Set Favorite icon to remove the corresponding item from the Favorites.

2. The item is removed from the Favorites, indicated by the hidden Set Favorite icon. The
next time you select the Favorites filter, the item will not be shown in the results list.

Solid

3.9  Editing the Files’ Tags and Properties

The Attribute Editor allows you to assign or edit tags and properties to your MASCHINE files to
make it easier to find them later when browsing the MASCHINE Library in the LIBRARY pane
(see section 13.2, Searching and Loading Files from the Library).

3.9.1  Attribute Editor Basics

The Attribute Editor is used in the following situations:
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= At any time you can edit the tags and properties of user files already in the Library by se-
lecting them in the Result list of the LIBRARY pane and clicking the EDIT button at the
bottom right of the Browser. After you have finished editing click APPLY to apply your
changes to the selected files, or click the lit EDIT button again to cancel you changes and
close the Attribute Editor. See section 13.2, Searching and Loading Files from the Library
for more information on the LIBRARY pane.

= When importing folders to the MASCHINE Library from the Browser’'s FILES pane, clicking
IMPORT at the bottom right of the Browser automatically opens the Attribute Editor so you
can tag the files being imported. After you have finished tagging click OK to import the
files to the Library and apply the selected tags, or click CANCEL to cancel the import. See
section 13.6, Loading and Importing Files from Your File System for more information on
the FILES pane.

1itern selected TYPES

Loops Metal Computear

Mall...ents MNolse Creature
Parcussion Famale

Metal Scratch Male

Multi FX SFX Phoneme

Multitrack Sin... Note Vocoder

Mico Strike

MNolse Swea...well

One Shots [] Vocal O

Cirean Fan

The Attribute Editor (here showing the TYPES page).

The Attribute Editor affects the files selected in the Result list of the LIBRARY pane (see sec-
tion 13.2.8, Loading a File from the Result List) or the files within the folders selected for im-
port in the FILES pane (see section 13.6, Loading and Importing Files from Your File System).

The Attribute Editor is organized into various pages:

= In the LIBRARY pane of the Browser, all pages are available: BANK, TYPES, MODES (In-
strument/Effect presets only), and PROPERTIES.

= In the FILES pane of the Browser, only the TYPES and MODES pages are available.
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» Click the desired tab at the top right of the Attribute Editor to show the corresponding
page.

@ You can adjust the overall height of the Attribute Editor by dragging its upper border.

The number of items selected appears in yellow in the upper left corner of the Attribute Editor.

Displaying Attributes of Factory Files

When browsing in the LIBRARY pane, if the files selected in the Result list are factory files
(i.e. files from any factory content) this will be indicated by a yellow read only item label next
to the EDIT button at the bottom of the Browser:

read only itern
Factory files are loaded in the Attribute Editor.

The Attribute Editor will display the various attributes for these files, but you won't be able to
modify them.

3.5.2  The BANK Page
The BANK page is only available when opening the Attribute Editor from the LIBRARY pane.

1item salected

e 2.0 Library

The BANK page of the Attribute Editor.

The BANK page shows you (from top to bottom) the product, bank, and sub-bank(s) of the se-
lected file(s). If any of these attributes are not set the corresponding fields read empty....
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You cannot modify the attributes shown in the BANK page — they are automatically assigned
by MASCHINE.

3.5.3  The TYPES and MODES Pages

The TYPES and MODES pages display and let you modify the tags assigned to the file(s) se-
lected in the Result list above.

= The TYPES page is available for all file types when opening the Attribute Editor both from
the LIBRARY pane and the FILES pane. It shows three columns (for Projects, Groups,
Sounds, and Samples) or two columns (for Instrument and Effect presets) according to the
hierarchical levels of the Type tags (see section 13.2.6, Selecting Type and Mode Tags):

1item selected TYPES

Loops ) Guitar Cowbaell

Mall...aents Hiha...sed Darabuka
Massive Influ...ops Djamba
Metal Percussion kA Guiro

Multi FX Snare Tabla
Multitrack Synth Triangle ol

MNico Vocal Various

= The MODES page is available when opening the Attribute Editor from the LIBRARY pane to
edit the tags of Instrument and Effect presets. When opening the Attribute Editor from the
FILES pane to import new files, the MODES page is always available, however it will be
taken into account only if Instrument or Effect presets are imported. The MODES page
shows only one column:

1item selected MODES
Additive

Arp...lated
Chaord

Dry

FM

Glid... Mod
Granular
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Displaying Tags

= In both TYPES and MODES pages, tags assigned to the selected files are marked with a
check mark right of their name:

Dalay

Distortion »
Downbeat

= |In the TYPES page, click the name of a tag to select it and display its Sub-Types in the
next column to the right. In each column only one tag can be selected. The selected tag is
highlighted:
MNolse Amblence
One Shots [] Analog FX

Organ Blip & Blop

Assigning Tags

» Click the empty check box right of the desired tag name to assign this tag to the selected
files.

— A check mark appears in the check box.
Additionally, when you check a tag on the TYPES page:

= If another column is available on the right the tag you check is automatically selected and
its Sub-Types appear in the next column (if any), allowing you to directly refine your de-
scription by checking the desired Sub-Types in this next column.

= |If you check a Sub-Type tag whose parent tag was not checked in the previous column on
the left, this parent tag will be automatically checked as well.

Be as precise as possible when tagging your files in order to be able to find what you are
looking for later.

Unassigning Tags
» Click the check mark right of the desired tag to unassign this tag from the selected files.

— The check mark disappears.
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In the TYPES page, if you uncheck a tag for which some Sub-Type tags were selected in
the columns on the right, these will automatically unassigned as you unassign their pa-
rent tag.

Creating New Tags
You can also create your own tags both in the TYPES and MODES pages:

» To create a new tag in any column, click the “+” symbol at the bottom of the column,
enter the desired tag name with your computer keyboard and press [Enter] to confirm.

Lo-Fi Snare
Loops O Synth
Mall...aents Vocal

Massive

“h

Adding a new Sub-Type for the Loops Type.

Deleting Tags

Tags in the TYPES and MODES pages cannot be deleted manually. However, if a tag is not as-
signed to any file anymore, it will be automatically removed from its column.

3.4  The PROPERTIES Page

The PROPERTIES page is only available when opening the Attribute Editor from the LIBRARY
pane.

1item salected PROPERTIES

The PROPERTIES page of the Attribute Editor.

The PROPERTIES page displays three additional attributes of the selected files:
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= Vendor: Use this field to indicate the manufacturer of the selected files. Click the down-
pointing arrow on the right to quickly select any Vendor attribute already in use in other
files of the Library.

= Author: Use this field to indicate the author of the selected files. Click the down-pointing
arrow on the right to quickly select any Author attribute already in use in other files of the
Library.

= Comment: Use this field to add any other information about the selected files.
As with the other pages of the Attribute Editor, the fields in the PROPERTIES page can

be modified only if you have selected user files in the Result list. The attributes of facto-
ry files cannot be edited.

3.6  Loading and Importing Files from Your File System

The Browser's FILES pane allows you to browse your file system and import the desired folders
to your MASCHINE Library.

» To display the FILES pane, click the FILES tab in the top left corner of the Browser.

3.6.1  Overview of the FILES Pane

The FILES pane contains following elements:
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FILES

Desktop  christian.schulz

@s + Drums »  Kick

The elements of the FILES pane.

(1) FILES tab: Click the FILES tab to open the FILES pane described here.

(2) Favorite bar: Displays all your Favorites. Click any Favorite to directly jump to that particular
path and display its content in the Result list (5). See section 13.6.2, Using Favorites.

(3) Location bar: Displays the selected path. The Location bar provides various tools to quickly
navigate your file system. See section 13.6.3, Using the Location Bar.
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(4) Recent Locations hutton: Click this button to see a list of the last visited locations and quick-
ly jump any of them. See section 13.6.4, Navigating to Recent Locations.

(5) Result list: The Result list displays the content (files and folders) of the folder loaded in the
Location bar (3). Only MASCHINE-compatible files are displayed. See section 13.6.5, Using
the Result List.

(6) Control bar: At the bottom of the Browser, the Control bar provides a few useful tools when
browsing your file system, some of them depending on the type of the files selected in the Re-
sult list:

= For all file types except Project, click the Autoload button at the far left of the Control bar to
automatically load the selected file in order to hear it in context with the rest of your
Project while it is playing. See section 13.3.1, Loading the Selected Files Automatically.

= For Samples, enable the Prehear button and adjust the volume fader next to it in order to
pre-listen to the selected Samples directly from the Browser in order to make a quick se-
lection. See section 13.3.2, Pre-Listening to Your Samples.

= For Groups, enable the Load Patterns checkbox to load the Group’s Patterns together with
the Group. See section 13.3.3, Loading Groups with their Patterns.

= For all files, click the Information button (showing a little “i”) near the EDIT button to dis-
play more information on the selected file(s). See section 13.3.4, Displaying File Informa-
tion.

= When a folder is selected, click the IMPORT button at the far right of the bar to import the
selected folder to the MASCHINE Library. Clicking the IMPORT button will open the Attrib-
ute Editor so you can assign tags to the selected files about to be imported. See section
13.5, Editing the Files’ Tags and Properties.

3.6.2  Using Favorites
Located at the top of the FILES pane, the Favorite bar displays all your Favorites.

Desktop  christian.schulz

The Favorite bar, at the top of the FILES pane.

Favorites are shortcuts to specific locations in your file system.

MASCHINE 2 - Manual - 124



Browser

Loading and Importing Files from Your File System

» Click any Favorite in the Favorite bar to jump to that location.
— The selected location is loaded in the Location bar and its content appears in the Result
list.

Favorites can be useful if you often return to the same location while browsing your file system
in the FILES pane: Save this location as a Favorite, and at any time you will be only one click
away from that location!

The default Favorites are the roots of each of your hard disks, your desktop folder, and your
user folder.

Adding and Removing Favorites
You can add your own Favorites to the Favorite bar. This is done in the Result list:

1. Navigate to the parent folder containing the folder you want to use as Favorite, so that
this folder appears in the Result list.

2. In the Result list, right-click ([Ctrl]-click on Mac OS X) the desired folder and select Add
to Favorites from the context menu.

S| Add to Favorites m
Import to Library
Refrash

Find in Fxnlorar

You can also remove any Favorite from the Favorite bar:

» To remove a Favorite, right-click it ([Ctrl]l-click it on Mac OS X) in the Favorite bar and
select Remove from Favorites.

3.6.3  Using the Location Bar

The Location bar shows and lets you modify the selected path. At any time the Result list will
display the content of the path shown here.

Workspace C: » Users » Gast »

The Location bar.
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The Location bar provides following tools:
= Up arrow: Click the Up arrow on the left to go one level up in your file system.

= Selected path: Within the path displayed, you can:

o Click any folder name to jump to that folder:

« Usars » Gdﬂ + Music

o Click any right-pointing arrow after a folder name to open a list of its subfolders, and
select any entry in the list to jump to that folder:

st » Music »
Mixes

MNaw Loops b
Sesslons - 2013-07

Sessions - 2013-08

Sesslons - 2013-09

o |f all the levels cannot be displayed in the path, click the double left-pointing arrow
left of the path to display the remaining upper levels (up to the Workspace, represent-
ing the highest level in your file system), and select any entry in the list to jump to

that location:

3.6.4  Navigating to Recent Locations

The Recent Locations button shows a clock icon at the right of the Location bar:

The Recent Location button.
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The last 10 locations you have visited are stored by MASCHINE and available here:
» Click the Recent Location button and select any recently visited location from the list.

— This location is loaded in the Location bar and its content displayed in the Result list.

3.6.5  Using the Result List

The Result list of the FILES pane shows the files and folders found in the path loaded in the
Location bar above (see section 13.6.3, Using the Location Bar).

Only MASCHINE-compatible files are shown in the Result list.

The Result list of the FILES pane.

If the list is too long to fit in the display, use your mouse wheel or drag the scroll bar on the
right to show the remaining items.
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In front of each file, an icon indicates the type of the file:

Icons for various file types.

Navigating Your File System in the Result List

You can further browse your file system in the Result list by opening any of the displayed fold-
er:

» Double-click a folder to display its content.

To return to the previous folder or to select any folder outside the folder currently displayed,
use the various tools located above the Result list:

= Favorites: 13.6.2, Using Favorites.
= Location bar: 13.6.3, Using the Location Bar.

= Recent Locations button: 13.6.4, Navigating to Recent Locations.

Selecting Files and Folders in the Result List

» To select a single file or folder in the Result list, click its entry.

You can also select multiple files and folders in the Result list in order to process them all at
once.

To select adjacent files in the list, do the following:

» Hold [Shift] on your computer keyboard and click two files in the Result list to select
these files and all files in-between.

To select distant files in the list, do the following:

» Hold [Ctrl] ([(Cmd] on Mac OS X) and click all the files you want to select.
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Loading Files from the Result List

You can load files from the Result list using the same methods as in the Result list of the
LIBRARY pane: via double-click or via drag-and-drop. For all details, please refer to section
13.2.8, Loading a File from the Result List.

Additional Features in the Result List

» Right-click ([Ctrl]-click on Mac OS X) any entry in the Result list to open a context menu
with additional commands.

Add to Favoritas
Import to Library
Refrash

Find in Explorer
+ Sort by Name
Sort by Date

The context menu in the Result list of the FILES pane (Windows depicted).
Following commands are available:

Command Description

Add to Favorites (folders only) Adds the selected folder to your Favorites. See section
13.6.2, Using Favorites for more information.

Import to Library (folders only) Imports the selected folder(s) into the Library. See section
13.6.5, Using the Result List for more information.

Refresh Refreshes the display of the list, in case items have been
modified in that folder.

Find in Exporer/ Find in Finder |QOpens an Explorer/Finder window pointing to the selected
folder.
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Command Description

Sort by Name Sorts the Result list according to the item names.

Sort by Date Sorts the Result list according to the item dates.

3.6.6  Importing Files to the MASCHINE Library

Apart from the huge MASCHINE factory library, you might want to use your own samples or any
MASCHINE files you received from other users. As described previously, you can load them di-
rectly from the FILES pane. If this can come in handy, e.g., to quickly check received files in a
MASCHINE context, it can get tedious when using the files on a regular basis. Furthermore,
you won't be able to find and load them from your controller nor from the LIBRARY pane (see
section 13.2, Searching and Loading Files from the Library).

For this you will have to import the files into the Library first. Importing files does not mean
they will be moved from the directory they currently reside in, they will only be referenced by
the Browser. That's why whenever you move files, make sure to update the paths to their re-
spective directories in the Library page of the Preferences panel, as described in section
12.6.4, Preferences — Default Page.

This section describes how to import files into the MASCHINE Library. When working on
a Project, you can also save individual objects (Project, Groups, Sounds, Plug-in presets,
or Samples) of the Project to the Library for later use. This will be described in each ob-
ject-specific section, later in this manual.

MASCHINE supports WAVE (.wav) and AIFF (.aiff) sample formats at a sample rate of
44.1 kHz or greater and a bit depth of 16 bits, 24 bits or 32 bits float.

The FILES pane allows you to import whole folders. All MASCHINE-compatible files found in
the selected folder(s) will be imported.

To import a folder, do the following:
1. Click the FILES tab at the top of the Browser to open the FILES pane.

2. In the FILES pane, navigate to the folder containing the folder you want to import. To do
this, use the various tools described in the previous sections.
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3. Select the desired folder as described above.

Click the IMPORT button at the bottom right of the Browser.
You will be presented with the Attribute Editor.

5. In the Attribute Editor, tag the files you are about to import to the Library as described in
section 13.5, Editing the Files’ Tags and Properties.

6. When you are done, click OK at the bottom right of the Browser to import the files to the
Library.

—  All MASCHINE-compatible files found in the selected folder(s) are imported to your Li-
brary. They are added as user content (User icon selected in the Content selector of the
LIBRARY pane, see section 13.2.5, Choosing Between Factory and User Content). Fur-
thermore, the paths of the imported folders are added to the list of user libraries in the
User pane of the Library page in the Preferences panel — see section 12.6.4, Preferen-
ces — Default Page for more information on this.

If the folder(s) you are importing contain different types of files (e.g., Samples, Sounds,
and Groups), the various imported files will be available by selecting the corresponding
types in the File Type selector (see section 13.2.4, Selecting a File Type).

You can also apply/remove tags at any time after they are imported. However, it may be
best to tag files on import, since it will make it easier to find them later.

Other Attributes Set During Import

In addition to the Type (and possibly) Mode tags that you can manually assign to the files be-
ing imported (see above), other attributes are automatically set as follows:

= For all file types, any attributes already assigned to the files will be retained.

= For Samples, if the product/bank/sub-bank attributes are empty, they will be set to the
folders in which the Samples are located:

o The product will be set to the name of the folder you have selected.

o |f Samples reside in a subfolder of this folder, the subfolder name will be used as
bank.
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o |f Samples reside in a subfolder of this subfolder, the name of the lower subfolder will
be used as sub-bank.

3.1  Locating Missing Samples

If you are loading a MASCHINE Project and one or more referenced Sample(s) cannot be found
for any reason, a dialog in which you can locate the missing Samples will appear.

Missing Sample

A sample could not be found.

C:/Users/Gast/Music/Apt A 12 (0.0s - 5.8s).wav

IGNORE ALL IGNORE LOCATE

The Missing Sample dialog allows you to locate missing Samples.

Sounds referencing missing Samples are marked with an exclamation mark. Additionally, their
Groups are also marked with an exclamation mark when selected.

The Missing Sample dialog shows you which Sample cannot be found. Three buttons at the
bottom of the dialog let you choose between following actions:

= IGNORE: Click this button to continue loading your Project without locating the missing
Sample. You will be able to locate it at a later time (see below).

= IGNORE ALL: Click this button to ignore the missing Sample as well as all other missing
Samples, if any. You will be able to locate them at a later time (see below).

= LOCATE: Clicking this button opens a Locate selection dialog in which you can manually
locate the missing Sample. Navigate to the desired Sample in your file system and click
Open. Consequently, your Project uses the newly selected Sample in place of the missing
one. If other Samples are missing, MASCHINE tries to trace their path starting from the
path you just indicated.
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Locating or Purging Missing Samples at a Later Time

When Sample references cannot be resolved, two additional Purge Missing Samples and Find
Missing Samples appear in the context menu of the affected Sound(s) in the Sound List.

Group B1 ~  Pattern 1
Drum Loop
Open...

Save
Save As...

Purge Missing Samplas h‘
Find Missing Samples

Import MIDI...
Export MIDI...
Color
Copy

Bacta

The Purge Missing Samples and the Find Missing Samples entries in the context menu of a Sound whose Sample is missing.

» Select Purge Missing Samples from the Sound slot’s context menu to remove the missing
Sample(s) from that Sound.

» Select Find Missing Samples from the Sound slot’s context menu to open the Missing
Sample dialog again and locate missing Samples for that Sound.

The same commands also appear in the context menu of the parent Group in the Group List,
as well as in the in the File submenu of the MASCHINE menu (in the MASCHINE Header):

= In the context menu of the parent Group, these commands will affect all Sounds with miss-
ing Samples in that Group.

= |n the File submenu of the MASCHINE menu, these commands will affect all Sounds with
missing Samples in your Project.
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3.8 Using Quick Browse

Quick Browse is a feature that allows you to quickly recall a search query you performed to get
to a given file. Let’s say you have loaded a kick Sample after browsing the Library, then loaded
a snare Sample to another Sound slot and now you realize you are not satisfied with that kick
Sample, but you heard a nice kick Sample just before you chose the current one. Normally you
would now have to try to remember the name or the tags you used to find it, or browse all kick
Samples (given that the MASCHINE Library already has several hundreds of kick Samples, this
may take a considerable amount of time). With Quick Browse you can restore the query with
just one click.

Quick Browse is available for Samples, Plug-ins presets (Instruments and Effects), Sounds,
Groups. Depending on the type of file you are looking for, the Quick Browse function is activat-
ed by clicking the magnifying glass in either of the following locations:

= Quick Browse for Projects, Groups and Sounds: Click the magnifying glass right of the colored
file name appearing in the upper left part of the Control area to recall the search query that
was used for that file. That file will be:

o The focused Group if the GROUP tab is selected above:
® GROUP
~ BlitchKit

)

Input

o The focused Sound if the SOUND tab is selected above:

Oh Baby [Loop]

)

Input
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= Quick Browse for Instrument/Effect presets and for Samples: Click the magnifying glass in the
upper right corner of the Control area to recall the search query that was used for the Plug-
in in the selected slot:

o |f a Sampler Plug-in is selected, it will recall the search query used for the Sample
loaded in that Sampler. If several Samples are loaded in the Sampler, it will recall the
search query for the Sample in the selected Zone in the Zone List.

o |If any other Instrument or Effect Plug-in is selected, it will recall the search query
used for the Plug-in preset loaded in that Plug-in (the preset name appears next to the
magnifying glass):

Flange Me 0

OuUTPUT

Upon your click on the magnifying glass, the search query for the corresponding file will be
restored in the LIBRARY or FILES pane of the Browser (depending on which of both panes was
used to find the file). The file will be shown in the Result list — if necessary, the list will be
scrolled to display the file. You can then choose other results for that query from the Result
list.

The Quick Browse function is also available from your controller! See below for more in-
formation.

If No Search Query Was Used for a File...

If a file of your Project wasn't loaded via a search in the Browser, obviously there is no search
query to be retrieved! Nevertheless, Quick Browse will try various techniques to find out where
the file “comes from.” For example, if you have loaded a file via drag and drop from your desk-
top or any other location on your computer, Quick Browse will display the FILES pane pointing
to that location.
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Overview of the Sounds, Groups, and Master

4 Managing Sounds, Groups, and Your Project

This chapter explains how to handle the various objects that structure any MASCHINE Project:
Sounds, Groups, and the Master.

4.1  Overview of the Sounds, Groups, and Master

In a MASCHINE Project, objects are organized into three hierarchic levels, from the lowest to
the highest:

= Sounds are played by the pads. They are loaded into Sound slots. In the software, in Ar-
range view Sound slots are displayed in the column at the left of the Pattern Editor: the
Sound List (1). Each Sound of the selected Group is by default mapped to one of the 16
pads on the MASCHINE hardware controller, so you can play all Sounds of a Group by
pressing the pads. Sounds are made up of any number of Plug-ins that process the audio
in series. Sounds are the only objects in MASCHINE that can accept Instrument Plug-ins
— these go in the Sounds’ first Plug-in slot. The type of the Plug-in (Instrument or Effect)
loaded in this first Plug-in slot will define the Sound’s role (audio source or bussing point,
respectively). For more information on Plug-ins and how they define the Sound’s role,
please refer to section 15.1, Plug-in Overview.

= Groups contain 16 Sound slots each with all their parameters. The 16 pads on your control-
ler can play one entire Group at a time. In the software, in Arrange view Group are dis-
played in the column at the left of the Arranger: the Group List (2). A MASCHINE Project
can have any number of Groups, which are organized in banks of eight Groups each. Each
Group can have any number of insert effects, which will globally apply to all Sounds con-
tained in that Group, as well as any number of Patterns organized in banks of 16 Patterns
each. More on Patterns in chapter 16, Working with Patterns.

= The Master is th